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Information for Readers Running 
Windows XP

 The graphics and operating system–related instructions in this book refl ect the Windows 

Vista user interface, but you can also use a computer running Windows XP with Service 

Pack 2 (SP2) installed. If you want to complete the workfl ow exercises, you will also need 

Microsoft .NET Framework 3.0 installed, which you can download from the Microsoft 

Download Center. 

 Most of the differences you will encounter when working through the exercises in this 

book on a computer running Windows XP relate to appearance rather than functional-

ity. For example, the Windows Vista Start button is round rather than rectangular and 

is not labeled with the word Start; window frames and window-management buttons 

look different; and if your system supports Windows Aero, the window frames might be 

transparent. In addition, fi le system dialog boxes and some fi le system paths are differ-

ent between the two platforms. For example, the My Documents folder in Windows XP is 

named Documents in Windows Vista. 

 In this section, we provide steps for navigating to or through menus and dialog boxes in 

Windows XP that differ from those provided in the exercises in this book. For the most 

part, these differences are small enough that you will have no diffi culty in completing 

the exercises. 

Managing the Practice Files
 The instructions given in the “Using the Book’s CD” section are specifi c to Windows 

Vista. The only differences when installing, using, uninstalling, and removing the practice 

fi les supplied on the companion CD are the default installation location and the uninstall 

process. 

 On a computer running Windows Vista, the default installation location of the practice 

fi les is Documents\Microsoft Press\SPD2007_SBS. On a computer running Windows XP, 

the default installation location is My Documents\Microsoft Press\SPD2007_SBS. If your 

computer is running Windows XP, whenever an exercise tells you to navigate to your 

Documents folder, you should instead go to your My Documents folder. 
   xi
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 To uninstall the practice fi les from a computer running Windows XP: 

  1. On the Windows taskbar, click the Start button, and then click Control Panel. 

  2. In Control Panel, click (or in Classic view, double-click) Add or Remove Programs. 

  3. In the Add or Remove Programs window, click Microsoft SharePoint Designer 

2007 Step by Step, and then click Remove. 

  4. In the Add or Remove Programs message box asking you to confi rm the deletion, 

click Yes. 

Using the Start Menu
 Folders on the Windows Vista Start menu expand vertically. Folders on the Windows XP 

Start menu expand horizontally. However, the steps to access a command on the Start 

menu are identical on both systems. 

 To start Microsoft Offi ce SharePoint Designer 2007 on a computer running Windows XP: 

 « Click the Start button, point to All Programs, click Microsoft Offi ce, and then click 

Microsoft Offi ce SharePoint Designer 2007. 

Navigating Dialog Boxes
 On a computer running Windows XP, some of the dialog boxes you will work with in 

the exercises not only look different from the graphics shown in this book but also work 

differently. These dialog boxes are primarily those that act as an interface between 

SharePoint Designer and the operating system, including any dialog box in which you 

navigate to a specifi c location. 

 For example, to navigate to the My Pictures folder in Windows XP: 

 « On the Places bar, click My Documents. Then in the folder content pane, double-

click My Pictures. 

 To move back to the My Documents folder in Windows XP: 

 « On the toolbar, click the Up One Level button. 

Up One LevelUp One Level



Features and Conventions of 
This Book

 This book has been designed to lead you step by step through all the tasks you are most 

likely to want to perform in Microsoft Offi ce SharePoint Designer 2007. If you start at the 

beginning and work your way through all the exercises, you will gain enough profi ciency 

to be able to create complex Web sites and pages. If you completed all the exercises and 

later need help remembering how to perform a procedure, the following features of this 

book will help you locate specifi c information: 

 O Detailed table of contents. Scan this listing of the topics and sidebars within each 

chapter to quickly fi nd the information you want. 

 O Chapter thumb tabs. Easily locate the beginning of the chapter you want. 

 O Topic-specifi c running heads. Within a chapter, quickly locate the topic you want 

by looking at the running head of odd-numbered pages. 

 O Detailed index. Look up specifi c tasks and features and general concepts in the 

index, which has been carefully crafted with the reader in mind. 

 O Companion CD. Install the practice fi les needed for the step-by-step exercises, and 

consult a fully searchable electronic version of this book and other useful resources 

contained on this CD. 

 In addition, we provide a glossary of terms for those times when you need to look up 

the meaning of a word or the defi nition of a concept. 

 You can save time when you use this book by understanding how the Step by Step series 

shows special instructions, keys to press, buttons to click, and other functionality. 
   xiii



xiv  Features and Conventions of This Book
 Convention Meaning

 

This icon indicates a reference to information stored on the book’s 
companion CD.

 USE This paragraph preceding a step-by-step exercise indicates the practice 
fi les or programs that you will use when working through the exercise.

 BE SURE TO This paragraph preceding or following a step-by-step exercise indicates 
any requirements you should attend to before beginning the exercise 
or actions you should take to restore your system after completing the 
exercise.

 OPEN This paragraph preceding a step-by-step exercise indicates fi les that 
you should open before beginning the exercise.

 CLOSE This paragraph following a step-by-step exercise provides instructions 
for closing open fi les or programs before moving on to another topic.

 1
2

Blue numbered steps guide you through hands-on exercises in each 
topic.

 1
2

Black numbered steps guide you through procedures in sidebars and in 
expository text.

 « An arrow indicates a procedure that has only one step.

 See Also These paragraphs direct you to more information about a given topic 
in this book or elsewhere.

 Troubleshooting These paragraphs warn you of potential missteps that might prevent 
you from continuing with the exercise.

 Tip

Note

These paragraphs provide a helpful hint or shortcut that makes work-
ing through a task easier, or information about other available options.

 Important These paragraphs point out information that you need to know to 
complete a procedure.

 Save

The fi rst time you are told to click a button in an exercise, a picture of 
the button appears in the left margin. If the name of the button does 
not appear on the button itself, it appears under the picture.

 F In step-by-step exercises, keys you must press appear as they would on 
a keyboard.

 H+> A plus sign (+) between two key names means that you must hold 
down the fi rst key while you press the second key. For example, “Press 

H+>” means “hold down the H key while you press the > key.”

 Program interface 

elements

In steps, the names of program elements, such as buttons, commands, 
and dialog boxes, are shown in black bold characters.

 User input Text that you are supposed to type is shown in blue bold characters.

Glossary terms Terms explained in the glossary are shown in blue italic type in the 
chapters.



Using the Book’s CD

The CD inside the back cover of this book contains documents that will provide you with 

additional information and it contains practice fi les you’ll use as you work through the 

exercises in this book. The CD also contains site templates that you use to create sites. By 

using practice fi les and site templates, you won’t waste time creating your own sample 

fi les and sites—instead, you can jump right in and concentrate on learning how to get 

the most of out of Microsoft Offi ce SharePoint Designer 2007.

What’s on the CD?
The following table lists the practice fi les and site templates necessary to complete the 

exercises, as well as sample site templates depicting the results of completed exercises, if 

the chapter includes them.

Chapter Additional Information, Practice Files, and .stp Files

Chapter 1: 
Introducing 
SharePoint Designer

Additional Documents\Microsoft Offi ce and SharePoint 

 Integration White Paper.doc

Additional Documents\SharePointProductsComparison.xls

Additional Documents\SharePointSitesAndWorkspaces_

 SG_E.ppt

Additional Documents\WSSVersions.doc

Chapter 2:
Working in 
SharePoint Designer

No practice fi les

Chapter 3:
Customizing a 
Web Page

Additional Documents\Microsoft_FrontPage_to_Expression_

 Web.doc

CustomWebPage\CustomWebPage_Solution.stp

Chapter 4:
Creating and Modifying 
Web Pages

WebPages\WebPages_Solution.stp

Chapter 5:
Working with Lists 
and Libraries

ListLib\ListLib_Solution.stp

Chapter 6:
Working with Data Views

DataViews\DataView_Starter.stp

DataViews\DataView_Solution.stp
   xv
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Chapter Additional Information, Practice Files, and .stp Files

Chapter 7:
Working with 
Data Sources

DataSources\DataSources_Starter.stp

DataSources\DataSources_Solution.stp

DataSources\Shipments.xml

Chapter 8:
Using Controls in 
Web Pages

Controls\Controls_Starter.stp

Controls\Controls_Solution.stp

Chapter 9:
Working with 
Master Pages

MasterPages\MasterPages_Starter.stp

MasterPages\MasterPages_Solution.stp

Chapter 10:
Changing the Look and 
Feel of Pages by Using 
Cascading Style Sheets

LookFeel\LookFeel_Starter.stp

LookFeel\LookFeel_Solution.stp

Chapter 11:
Managing Web Content 
in a SharePoint Server 
Environment

No practice fi les

Chapter 12:
Understanding 
Workfl ows

Workfl ows\Workfl ows_Starter.stp

Workfl ows\Workfl ows_Solution.stp

Chapter 13:
Building a Windows 
SharePoint Services 
Application

BuildApps\BuildApps_Starter.stp

BuildApps\BuildApps_Solution.stp 

Additional Documents\Application Templates Under 

 the Hood.doc

Chapter 14:
Managing 
SharePoint Sites

No practice fi les

Chapter 15:
Understanding Usability 
and Accessibility

UsabilityAccessibility\Index.aspx

In addition to the practice fi les, starting site templates, and sample solution site tem-

plates, the CD also includes exciting resources that will enhance your ability to get the 

most out of using this book and SharePoint Designer, including an electronic version of 

the book in PDF format.
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Minimum System Requirements
To use this book, your client computer should meet the following requirements:

O Processor. Pentium 700 megahertz (MHz) or higher; 2 gigahertz (GHz) 

recommended.

O Memory. 512 megabytes (MB) of RAM; 1 gigabyte (GB) or more recommended.

O Hard disk. For the eBooks and downloads, we recommend 3 GB of available hard 

disk space with 2 GB on the hard disk where the operating system is installed.

O Operating system. Windows Vista or later, Windows XP with Service Pack 2 (SP2), 

or Windows Server 2003 with Service Pack 1 (SP1) or later. To complete the workfl ow 

exercises, you will need Microsoft .NET Framework 3.0, which is incorporated into 

Windows Vista, but not into Windows XP or Windows 2003.

O Drive. CD or DVD drive.

O Display. Monitor with 1024x768 or higher screen resolution and 16-bit or higher 

color depth.

O Software. Windows Internet Explorer 7 or later; or Microsoft Internet Explorer 6 

with service packs.

Tip Actual requirements and product functionality may vary based on your system 
confi guration and operating system.

Step-by-Step Exercises

In addition to the hardware, software, and connections required to run SharePoint 

Designer, you will need the following to complete successfully the exercises in this book:

O Microsoft Offi ce SharePoint Designer 2007

O 14 MB of available hard disk space for the practice fi les
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Server Computer
To use this book, you must have access to a server running Windows SharePoint Services 
or SharePoint Server 2007. The server computer should meet the following requirements:

●	 Operating system. Windows Server 2003 SP1 or Windows Server 2003 x64 or 
Windows Small Business Server 2003; and the .NET Framework 3.0

●	 Software. Microsoft Windows SharePoint Services 3.0 or Microsoft Office 
SharePoint Server 2007

Note  The CD for this book does not contain the Windows Server 2003 operating system, 
or the Windows SharePoint Services or SharePoint Server software. You must have access to 
a working site before using this book. Windows SharePoint Services 3.0 can be downloaded 
from the Microsoft Download Center for no cost.

lling the Practice Files
You need to install the practice files in the correct location on your hard disk before you 
can use them in the exercises. Follow the steps below.

Note  If for any reason you are unable to install the practice files from the CD, the files can 
also be downloaded from the web at http://www.microsoftpressstore.com/title/9780735623057

.

To install the files from the CD:

1.	 Remove the companion CD from the envelope at the back of the book, and insert 
it into the CD drive of your computer.

The Step By Step Companion CD License Terms appear. Follow the on-screen direc-
tions. To use the practice files, you must accept the terms of the license agreement. 
After you accept the license agreement, a menu screen appears.

Important  If the menu screen does not appear, click the Start button and then click 
Computer. Display the Folders list in the Navigation Pane, click the icon for your CD 
drive, and then in the right pane, double-click the StartCD executable file.
2.	 Click Practice Files.

If you are installing the practice files on a computer running Windows Vista, a File 
Download – Security Warning dialog box opens.

3.	 Click Run, and when an Internet Explorer – Security dialog box opens, click Run.

The Microsoft Office SharePoint Designer Step By Step dialog box opens.

http://wwww.microsoftpressstore.com/title/9780735623057
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4.	 Click Next on the first screen, click I accept the terms in the license agreement, 
and then click Next.

5.	 If you want to install the practice files to a location other than the default folder 
(Documents\Microsoft Press\SPD2007_ SBS), click the Change button, select the 
new drive and path, and then click OK.

Important  If you install the practice files to a location other than the default, you 
will need to substitute that path within the exercises.

6.	 Click Next on the Custom Setup page, and then click Install on the Ready to 
Install the Program screen to install the selected practice files. If a User Account 
dialog box opens stating that an unidentified program wants to access your com-
puter, click Allow.

7.	 After the practice files have been installed, click Finish.

8.	 Close the Step by Step Companion CD window, remove the companion CD from 
the CD drive, and return it to the envelope at the back of the book.

g the Practice Files
When you install the practice files and sample sites from the companion CD, the files 
are stored on your hard disk in chapter-specific subfolders under Documents\Microsoft 
Press\SPD2007_SBS.

Wherever possible, we start each chapter with a standard Windows SharePoint Services 
team site. It doesn’t mean that if you follow all exercises in all chapters in sequence, you 
have to start with a new team site for every chapter—you can use the same site through
out the whole book. You should be a site owner of this site. During the exercises, you will 
be creating child sites below this team site and, for some chapters, you will be provided 
with a starter site template .stp file to use to create the child site.

The site template .stp files provided on the CD contain lists, libraries, files, and pages that 
you will use during the exercises. For chapters that require the creation of a site based on 
a site template, a Housekeeping segment in the beginning of each chapter lists the site 
template .stp files needed for that chapter. The text also explains any preparation you 
need to take before you start working through the chapter.
Important  Before you can use the practice files in this chapter, you need to install them 
from the book’s companion CD to their default location. See “Using the Book’s CD.” You will 
need to create a practice site for this chapter based on site template DataSources_Starter.stp 
in the practice file folder for this chapter.
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If the chapter requires you to create a practice site, please refer to “Using the .stp Site 

Templates” later in this section for instructions to create a practice site.

Each exercise within a chapter is preceded by a Housekeeping segment that lists the prac-

tice fi les needed for that exercise. The text also explains any preparation you need to 

take before you start working through the exercise, as shown here:

USE the Shipments.xml fi le. This practice fi le is located in the Documents\Microsoft Press\

SPD2007_SBS\DataSources folder. Also, use your own SharePoint site, instead of the teams.

consolidatedmessenger.com/DataSources team site.

BE SURE TO start SharePoint Designer before beginning this exercise.

OPEN the Shipments.xml fi le.

You can browse to the practice fi les in Windows Explorer by following these steps:

 1. On the Windows taskbar, click the Start button, and then click Documents.

 2. In your Documents folder, double-click Microsoft Press, double-click SPD2007_SBS, 

and then double-click a specifi c chapter folder.

Removing the Practice Files
You can free up hard disk space by uninstalling the practice fi les that were installed 

from the companion CD. The uninstall process deletes any fi les that you created in the 

Documents\Microsoft Press\SPD2007_SBS folder while working through the exercises.

Follow these steps:

 1. On the Windows taskbar, click the Start button, and then click Control Panel.

 2. Under Programs, click Uninstall a program.

 3. Click Microsoft Offi ce SharePoint Designer 2007 Step by Step, and then click 

Uninstall.

The Programs And Features dialog box opens.

 4. Click Yes.

The User Account Control dialog box opens.

 5. Click Allow.

Important Microsoft Product Support Services does not provide support for this book or 
its companion CD.

USE thethe Shipments.xmlShipments.xml fi le. This practice fi le is located in the fi le. This practice fi le is located in the ll Documents\Microsoft Press\Documents\Microsoft Press\

SPD2007_SBS\DataSourcesSPD2007_SBS\DataSources folder. Also, use your own SharePoint site, instead of thefolder. Also, use your own SharePoint site, instead of the teams.teams.

consolidatedmessenger.com/DataSourcesconsolidatedmessenger.com/DataSources team site. team site.

BE SURE TO start SharePoint Designer before beginning this exercise.start SharePoint Designer before beginning this exercise.

OPEN thethe Shipments.xmlShipments.xml fi le. fi le.ll

StartStart

StartStart
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Using the .stp Site Templates
To create a practice site for a chapter based on a site template .stp fi le provided on the 

CD, perform the following steps.

BE SURE TO verify that you have suffi cient rights to upload a site template to a top-level 
site and to create a site in the site collection.

OPEN in the browser the top-level SharePoint site to which you’d like to upload the site 
template .stp fi le. If prompted, type your user name and password, and then click OK.

 1. Click Site Action, and then click Site Settings to display the Site Settings page.

Tip If you are using the .stp fi les on a SharePoint Server installation, clicking Site 
Settings will display a secondary menu. Click Modify All Site Settings to display the 
Site Settings page.

 2. Under Galleries, click Site templates to display the Site Template Gallery page.

Tip If you see a Go To Top-level Site Settings link under Site Collection Administration, 
you are not on the top-level site administration page. A site template can only be 
uploaded to the Site Template Gallery on a top-level site. Click Go To Top-level Site 
Settings, and then repeat the previous step.

 3. Click Upload to display the Upload Template: Site Template Gallery page.

 4. Click the Browse button to open the Choose File dialog box.

 5. Navigate to Documents\Microsoft Press\SPD2007_SBS\XXX where XXX is the folder 

associated with the chapter, click the .stp fi le that you want to use to create the new 

site, and then click the Open button.

 6. Click OK.

The Site Template Gallery: XXX page is displayed.

 7. Click OK to redisplay the Site Template Gallery page.

You can now create a new child site based upon the uploaded template.

 8. Open in the browser the SharePoint site that you’d like to create the new practice 

site within.

 9. Click Site Actions, and then click Create to display the Create page.

BE SURE TO verify that you have suffi cient rights to upload a site template to a top-levelverify that you have suffi cient rights to upload a site template to a top-level
site and to create a site in the site collection.site and to create a site in the site collection.

OPEN in the browser the top-level SharePoint site to which you’d like to upload the sitein the browser the top-level SharePoint site to which you’d like to upload the site
template .stp fi le. If prompted, type your user name and password, and then click OK.template .stp fi le. If prompted, type your user name and password, and then click OK.
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 10. Under Web Pages, click Sites and Workspaces to display the New SharePoint Site 

page.

 11. In the Title text box, type a logical name for the new site; you could simply provide 

the chapter name, for example DataViews.

 12. Optionally, in the Description text box, type a description, for example SharePoint 

Designer SBS Chapter 6 Data Views.

 13. In the URL name text box, repeat the same name as you typed in the Title text 

box.

 14. In the Template Selection section, click the Custom tab, and then click the name of 

the template that you just uploaded, for example DataViews Starter. 

 15. In the Permissions, Navigation, and Navigation Inheritance sections, leave the 

default settings.

 16. Click Create.

The home page of the new practice site is displayed.

CLOSE the browser.

Removing the .stp Site Templates
To remove the chapter starter templates from the Site Template Gallery, perform the 

following steps.

BE SURE TO verify that you have suffi cient rights to delete a site template from the top-
level Site Template Gallery.

OPEN the top-level SharePoint site where you previously uploaded the site template STP 
fi les. If prompted, type your user name and password, and then click OK.

 1. Click Site Action, and then click Site Settings to display the Site Settings page.

 2. Under Galleries, click Site templates to display the Site Template Gallery page.

Note If you see a Go To Top-level Site Settings link under Site Collection 
Administration, you are not on the top-level site administration page. A site template 
can only be uploaded to the Site Template Gallery on a top-level site. Click Go To 
Top-level Site Settings, and then repeat the previous step.

BE SURE TO verify that you have suffi cient rights to delete a site template from the top-verify that you have suffi cient rights to delete a site template from the top-
level Site Template Gallery.level Site Template Gallery.

OPEN the top-level SharePoint site where you previously uploaded the site template STP the top-level SharePoint site where you previously uploaded the site template STP 
fi les. If prompted, type your user name and password, and then click OK.fi les. If prompted, type your user name and password, and then click OK.
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 3. Click the Edit icon to display the details for the site template.

 4. Click Delete item to remove the site template. You will be prompted to confi rm 

your request. Click OK to complete the deletion and redisplay the Site Template 

Gallery.

 5. Repeat the edit-and-delete steps to remove each site template that you no longer 

want available for the creation of practice sites.

CLOSE the browser.

Deleting a Practice Site
If you created a practice site that you no longer want, you can delete it. Perform the 

following steps to delete a practice site:

BE SURE TO verify that you have suffi cient rights to delete a site. 

OPEN in the browser the SharePoint site you want to delete. If prompted, type your user 
name and password, and then click OK.

 1. On the Site Actions menu, click Site Settings to display the Site Settings page.

 2. In the Site Administration section, click Delete this site to display the Delete This 

Site confi rmation page.

 3. Click the Delete button to delete the site.

Important Microsoft Product Support Services does not provide support for this book or 
its companion CD.

EditEdit

BE SURE TO verify that you have suffi cient rights to delete a site.verify that you have suffi cient rights to delete a site.

OPEN in the browser the SharePoint site you want to delete. If prompted, type your user in the browser the SharePoint site you want to delete. If prompted, type your user 
name and password, and then click OK.name and password, and then click OK.
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Getting Help
Every effort has been made to ensure the accuracy of this book and the contents of its 
CD. If you run into problems, please contact the appropriate source, listed in the follow-
ing sections, for help and assistance.

Errata & Book Support
If you find an error, please report it on our Microsoft Press site:

	 2.	 In the Search box, enter the book’s ISBN or title.

	 3.	 Select your book from the search results.

	 5.	 Click View/Submit Errata.

You’ll find additional information and services for your book on its catalog page. If you 
need additional support, please e-mail Microsoft Press Book Support at mspinput@
microsoft.com.

If for any reason you are unable to install the practice files from the CD, the files can also 
be downloaded from the web here:

http://www.microsoftpressstore.com/title/9780735623057

Please note that product support for Microsoft software is not offered through the  
addresses above.

Getting Help with SharePoint Designer
If your question is about Microsoft Office SharePoint Designer, and not about the con-
tent of this Microsoft Press book, please search the Microsoft Help and Support Center 
or the Microsoft Knowledge Base at:

support.microsoft.com

1. Go to www.microsoftpressstore.com.

4. On your book’s catalog page, find the Errata & Updates tab.

http://www.microsoftpressstore.com/title/9780735623057
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In the United States, Microsoft software product support issues not covered by the 
Microsoft Knowledge Base are addressed by Microsoft Product Support Services. 
The Microsoft software support options available from Microsoft Product Support 
Services are listed at:

www.microsoft.com/services/microsoftservices/srv_support.mspx

Outside the United States, for support information specific to your location, please refer 
to the Worldwide Support menu on the Microsoft Help and Support Web site for the site 
specific to your country:

support.microsoft.com/common/international.aspx

We Want to Hear from You
At Microsoft Press, your satisfaction is our top priority, and your feedback our most valu-
able asset. Please tell us what you think of this book at:

http://www.microsoft.com/learning/booksurvey

The survey is short, and we read every one of your comments and ideas. Thanks in  
advance for your input!

Stay in Touch
Let’s keep the conversation going! We’re on Twitter: http: //twitter.com/MicrosoftPress
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In this chapter, you will learn to:

� Explore the SharePoint Designer workspace.

� Use toolbars.

� Use task panes.

� Create a SharePoint site hierarchy.

� Delete a SharePoint site.

After you start Microsoft Offi ce SharePoint Designer 2007, you can interact with the pro-

gram by using fi ve interface elements: the document window, menu bar, toolbars, task 

panes, and context-sensitive menus. By using these fi ve elements, you can create, modify, 

and delete SharePoint sites, connect to a variety of data sources (not just the data held 

within Microsoft SQL Server databases), create input forms, manage the validation of the 

data entry on these forms, and develop sophisticated business applications. 

In this chapter, you will explore the SharePoint Designer 2007 workspace and learn about 

these fi ve interface elements. You will also learn how to create and delete a SharePoint site. 

Important No practice fi les are required to complete the exercises in this chapter. For 
more information about practice fi les, see “Using the Book’s CD” at the beginning of this 
book. 

Troubleshooting Graphics and operating system–related instructions in this book 
refl ect the Windows Vista user interface. If your computer is running Windows XP and you 
experience trouble following the instructions as written, please refer to the “Information for 
Readers Running Windows XP” section at the beginning of this book. 

Troubleshooting Graphics and operating system–related instructions in this bookGraphics and operating system–related instructions in this book
refl ect the Windows Vista user interface. If your computer is running Windows XP and yourefl ect the Windows Vista user interface. If your computer is running Windows XP and you
experience trouble following the instructions as written, please refer to the “Information forexperience trouble following the instructions as written, please refer to the “Information for
Readers Running Windows XP” section at the beginning of this book.Readers Running Windows XP” section at the beginning of this book.
  23
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Exploring the SharePoint Designer Workspace
When you start SharePoint Designer, you are presented with its workspace. The SharePoint 

Designer program window contains a number of elements. Initially these elements are in 

specifi c locations within the program window; however, you can move them to other 

areas of the program window or close them. You can customize the program window to 

assist you in creating solutions that meet your business needs. 

Status bar

Title bar Menu bar Common toolbar

Document windowTask panes
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Important elements of the SharePoint workspace include the following: 

O Title bar. This contains the program name and the site name, if one is open. 

O Menu bar. The menu bar has 12 menus on it, many of which have a similar func-

tion to those you have used in other Offi ce applications; for example, with the File 

menu, you can perform common fi le-based operations such as New, Open, Save, 

and Save As, and with the Edit menu, you can perform common word-processing 

operations such as cut, copy, paste, and delete text. You may not have seen these 

three new menu items before: Site, Data View, and Task Panes. You will use these 

menu items as you progress through this book. 

O Common toolbar. This is one of 11 toolbars available to you. The Common toolbar 

appears by default under the menu bar and provides the common commands that 

you will use. 

O Document window. When a site is open, this window contains the Web Site tab, 

which displays the contents of a site, and a tab for each page you open. In this 

window, you modify a page, either by manipulating the components or by writing 

code; therefore, this windows is also known as the editing window. 

O Task panes. Task panes are placed in one of four areas within the SharePoint 

Designer program window. When you open SharePoint Designer, by default, six 

tasks panes are opened in four areas: the Folder List task pane opens in the upper 

left, the Tag Properties and CSS Properties task panes in the lower left, the Toolbox 

task pane in the upper right, and the Apply Styles and Manage Styles task panes 

in the lower right. You can open any of the 24 task panes by using the Task Panes 

menu item on the menu bar. 

O Status bar. The status bar contains information such as estimating the time to 

download a page from a Web server, the size of the page, cascading style sheet 

version, and code errors. 

You can change the way SharePoint Designer starts up by using the Applications Options 

dialog box, which you can open from the Tools menu. You use this dialog box to con-

fi gure whether to open the last site automatically when SharePoint Designer starts and 

to show or hide the Status bar. Use the Proxy Settings option to alter the Internet 

Properties options of your browser, and the Confi gure Editors tab to associate fi le types 

with any editor on your computer. The default editor is used when you double-click a fi le 

in the Folder List task pane or when you right-click a fi le and click Open on the context-

sensitive menu. 
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In this exercise, you will explore the SharePoint Designer workspace, open and close a 

SharePoint site, and review the startup settings of SharePoint Designer. 

USE the teams.consolidatedmessenger.com site (the top-level site of a site collection based 
on the team site template), or any team site you want.

1. On the taskbar, click the Start button, click All Programs, click Microsoft Offi ce, 

and then click Microsoft Offi ce SharePoint Designer. 

The SharePoint Designer program window opens. 

Tip By default, SharePoint Designer remembers the last site you worked on and 
opens it when you open the program. In this case, you may see a site listed in the 
Folder List task pane. 

2. On the File menu, click Open Site. 

The Open Site dialog box opens. 

3. In the Site name text box, type http://teams.consolidatedmessenger.com, and 

then click Open. If prompted, type your user name and password, and click OK. 

Important SharePoint Designer uses the Internet Properties security settings of the 
browser to decide whether to prompt for credentials. 

The contents of the SharePoint site are listed in the Folder List task pane and on the 

Web Site tab in the document window. At the bottom of the Web Site tab are 

the view buttons: Folders, Remote Web Site, Reports, Navigation, and Hyperlinks. 

4. On the Web Site view bar, click Navigation. 

Tip An alternative is to click Navigation on the Site menu. 

The Navigation view of the site appears. The Quick Launch link bar and the labels 

on the Quick Launch bar, such as Documents, Lists, Discussions, and Sites, are repre-

sented by boxes with globe symbols. There is also a box with a globe symbol that 

represents the SharePoint navigation bar. If this site had child sites and you had 

specifi ed to display links to the child site on the top link bar of the parent site, you 

would see these links under the SharePoint navigation bar box. 

USE thethe teams.consolidatedmessenger.comteams.consolidatedmessenger.com site (the top-level site of a site collection based site (the top-level site of a site collection based 
on the team site template), or any team site you want.on the team site template), or any team site you want.

StartStart
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You can manage the Quick Launch bar and the SharePoint navigation bar by using 

this view unless the parent navigation was based on a site collection that used the 

Collaboration Portal or Publishing Portal site templates. 

5. On the Tools menu, click Application Options. 

The Application Options dialog box opens displaying the General tab where the 

Startup options are listed .

6. Click OK. 

The Application Options dialog box closes. 

BE SURE TO leave SharePoint Designer open if you are continuing to the next exercise.
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Using Toolbars
 SharePoint Designer consists of 11 built-in toolbars that provide you with a visual way 

of manipulating elements on your pages. Many of these toolbars are similar to the ones 

you use in other Microsoft Offi ce applications, such as Standard, Formatting, Common, 

and Tables. A number of them are SharePoint Designer–specifi c: Code View, Dynamic 

Web Template, Master Page, Pictures, Positioning, Style, and Style Application. As with 

other Offi ce applications, you can decide to show multiple toolbars simultaneously, and 

by default, SharePoint Designer will dock them under the menu bar. You can decide to 

dock them in other locations or to undock them completely and have them fl oat over 

the program window. You can create your own toolbars and customize the existing 

toolbars. 

 In this exercise, you will customize the Common toolbar. 

BE SURE TO start SharePoint Designer if you exited after the last exercise. If SharePoint 
Designer opens a previous site, click Close Site on the File menu.

  1. On the View menu, point to Toolbars, and then click Customize (or click 

Customize on the Tools menu). 

 The Customize dialog box opens. 

  2. Click the Commands tab, and then in the right pane, under Commands, scroll 

down until you fi nd Close Site. 

  3. Drag Close Site next to the Open icon on the Common toolbar. 

BE SURE TO start SharePoint Designer if you exited after the last exercise. If SharePoint start SharePoint Designer if you exited after the last exercise. If SharePoint 
Designer opens a previous site, click Close Site on the File menu.Designer opens a previous site, click Close Site on the File menu.

OpenOpen
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Close Site appears on the Common toolbar. 

 4. In the Customize dialog box, click the Toolbars tab, select Common, and then click 

Reset. 

A dialog box prompts you to confi rm that you want to reset the changes made to 

the Common toolbar. 

 5. Click OK. 

The Close Site command disappears from the Common toolbar. 

CLOSE the Customize dialog box, and then exit SharePoint Designer.

Using Task Panes
Task panes are helper windows that you can use to perform certain tasks, such as modi-

fying HTML tag properties, adding ASP.NET controls and Web Parts to your pages, and 

managing cascading style sheets. You can open, close, and move task panes to the sides 

of the SharePoint Designer program window or make them fl oat so that they appear in 

the middle of the program window. When you fi rst open SharePoint Designer, only four 

task panes open and are placed on the right and left sides of the SharePoint Designer 

program window. Other task panes can be opened from the Task Pane menu. SharePoint 

Designer provides you with 24 task panes, listed in the following table. 

Task pane Description

Folder List Displays the contents of a SharePoint site. Use this as you 
would Windows Explorer; that is, you can cut, copy, paste, 
rename, and delete fi les and folders between different sites 
and fi le systems. Any metadata associated with a fi le or 
folder are copied and are visible if the receiving document 
library has the same column name and type, but permissions 
and multiple versions are not transferred with the fi le.

Navigation Displays a visual representation of the navigation struc-
ture of a SharePoint site in a tree-like view, similar to the 
Navigation view described earlier in this chapter, and in-
cludes the Quick Launch bar and SharePoint Top Navigation 
bar.

Tag Properties Use to manipulate HTML tag properties, which are grouped 
into three categories: attributes, events, and misc(ellaneous). 

(continued on next page)
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Task pane Description

CSS Properties Use when working with cascading style sheets, particu-
larly when manipulating cascading style sheet class, ID, 
or tag defi nitions. Use as an alternative to launching the 
Modify Style dialog box.

Layout Tables Provides visual aids for designing and working with tables.

Apply Styles Use to create new cascading style sheet styles and apply ex-
isting ones to elements within pages.

Manage Styles Use to manage cascading style sheet styles that you have 
added to elements within pages.

Behaviors Lists behaviors that you can add to pages. Behaviors are 
SharePoint Designer alternatives to writing JavaScript.

Layers Use to insert and confi gure layers. A layer is the name given 
to an absolute positioned HTML division (DIV) tag. You use 
the DIV tag to group elements together so that you can for-
mat them with styles, or create animations or fl yout menus.

 Toolbox Lists HTML tags, form controls, ASP.NET controls, and 
SharePoint controls that you can place on pages by drag-
ging and dropping.

 Data Source Library Use to manage connections to data sources such as 
SharePoint lists and libraries (both for the current site and 
remote sites), Database Connections, XML fi les, and server-
side scripts including RSS feeds, XML Web Services, Business 
Data Catalog, and Linked Sources, such as data sources that 
have similar columns and you would like to display the con-
tents of these data sources together.

 Data Source Details Use to display or modify contents of the data sources de-
fi ned in the Data Source Library task pane, by using either 
the Data View Web Part (DVWP) or Data Form Web Part 

(DFWP).

 Conditional Formatting Use to format the data in a DVWP or DFWP based on 
criteria that you specify.

 Find Data Source Use to search data sources defi ned in the Data Source 
Library task pane.

 Web Parts Use to add Web Parts to pages from the site’s Web Part 
Gallery or the Server Web Part Gallery; similar to the Add 
Web Part tool pane in the browser, but it does not expose 
the Close Web Part gallery.
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Task pane Description

Find 1 Use to search and replace text, code, and HTML within a 
page. This and the following task panes appear when you 
use the Find option on the Edit menu. You can fi nd and 
replace text on one page, a number of pages, or the whole 
site. You can also fi nd words in the code and regular expres-
sions.

Find 2 Displays a second search task pane. Use when you want to 
leave the search results in the Find 1 task pane, but need to 
complete another search.

Accessibility Use to check pages and sites against Web Content 
Accessibility Guidelines (WCAG) and Priority 1 and 2. This 
task pane appears when you use the Accessibility Reports 
option on the Tools menu.

Compatibility Use to validate pages and sites for well-formed HTML/XTML 
or cascading style sheet versions. The Compatibility Checker 
currently supports CSS 2.1, 2.0, 1.0 and CSS IE6. This task 
pane appears when you use the Compatibility Reports op-
tion on the Tools menu.

Hyperlinks Use to check and fi x broken links.

CSS Reports Use to check pages for cascading style sheet errors and 
highlight those cascading style sheet styles that are not 
used. This task pane appears when you use the CSS Reports 
option on the Tools menu.

Clip Art Use to search for Clip Art.

Clipboard Allows you to view up to 24 thumbnails of any item that can 
be cut or copied by an Offi ce program (text, graphics, pho-
tographs, and more).

Contributor Shows your contributor status and allows you to manage 
Contributor Settings if you are a site owner or administrator. 
Use Contributor Settings to control how SharePoint Designer 
is used to modify a SharePoint site.

The last option on the Task Pane menu, Reset Workspace Layout, allows you to restore the 

task panes to their default positions; that is, the Folder List task pane opens in the upper-

left corner of the program window, the Tag Properties and CSS Properties task panes in 

the lower-left corner, the Toolbox task pane in the upper-right corner, and the Apply 

Styles and Manage Styles task panes in the lower-right corner.
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In this exercise, you will view and manage task panes. 

OPEN the teams.consolidatedmessenger.com team site, or whatever site you want to use, 
and enter your credentials if prompted to do so.

1. On the Edit menu, click Find. 

The Find And Replace dialog box opens. 

2. In the Find what text box, type MasterPageFile, and click All pages under Find 

where. 

3. Select the Match case and Find whole word only check boxes under Advanced. 

Clear any other options that are selected under Advanced. 

4. Click Find All. 

The Find And Replace dialog box closes, and the Find 1 task pane opens, docking 

at the bottom of the document window. The status bars of both the SharePoint 

Designer program window and the Find 1 task pane indicate the progress of the 

search. When complete, the Find 1 task pane status bar informs you that no occur-

rences of ‘MasterPageFile’ were found. 

OPEN thethe teams.consolidatedmessenger.comteams.consolidatedmessenger.com team site, or whatever site you want to use, team site, or whatever site you want to use,
and enter your credentials if prompted to do so.and enter your credentials if prompted to do so.
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 5. In the Find 1 task pane, click the Find and Replace button. 

The Find And Replace dialog box opens. 

 6. Under Advanced, select Find in source code and click Find All. 

The Find And Replace dialog box closes, and as before, the status bars indicate 

the progress of the Find process; the Find 1 task pane displays the results. In a 

newly created SharePoint site, each page refers to a master page. The number of 

pages returned in the results are dependent on the site template the site was cre-

ated from and whether the site is created in a Windows SharePoint Services or 

SharePoint Server installation. 

 7. In the Find 1 task pane, click the Next Result button. 

The fi rst page in the results list opens in a new tab in the document window in 

Code view, with the fi rst instance of the text you are looking for highlighted. 

Tip To continue searching the page for the next occurrence of the word, you would 
click the Next Result button; to fi nd the previous occurrence of the search keyword, 
you would click the Previous Result button. When no more occurrences of the search 
keyword can be found on the current page, the next page in the results list opens in 
a new tab if the page is not already open. To open a specifi c page, double-click the 
page in the results list. To save your common fi nd-and-replace searches, in the Find 
And Replace dialog box, click the Save Query button. To use a saved query, click the 
Open Query button. 

 8. On the Task Panes menu, click Clipboard. 

The Clipboard task pane docks to the right edge of the SharePoint Designer 

program window. 

 9. Click Task Panes. 

In the graphic shown on the next page, notice that the task panes displayed in 

the drop-down menu are grouped together, separated with a horizontal line. Task 

panes in the same group open in the same area of the SharePoint Designer pro-

gram window. Task panes that open in the same area appear as tabs. 

Find and ReplaceFind and Replace

Next ResultNext Result
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 10. In the lower-left corner of the Find 1 task pane, click the Close button. 

The Find 1 task pane closes. 

Tip Close task panes when you no longer need them, because they reduce the space 
available for the document window area. 

 11. In the lower-right task pane area, click the Manage Styles tab. 

The title bar above the Manage Styles tab turns orange, indicating that the Manage 

Styles task pane has the focus. 

 12. Point to the orange Manage Styles task pane title. When the pointer changes to 

a four-headed arrow, drag the task pane to the lower left corner of the program 

window. 

The lower-left task pane now contains tabs for Tag Properties, CSS Properties, 

Apply Styles, and Manage Styles. 

Note The Clip Art, Clipboard, and Contributor task panes cannot be moved or 
merged with the other task panes and will always open in a separate window docked 
at the right side of the SharePoint Designer program window. 

CloseClose
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 13. Click the left arrow below the Manage Styles task pane title until you see the Tag 

Properties task pane. 

 14. On the Task Panes menu, click Reset Workspace Layout. 

 SharePoint Designer displays the four default task panes in their original position. 

CLOSE SharePoint Designer.

Creating a SharePoint Site Hierarchy
 In Chapter 1, “Introducing SharePoint Designer,” we described the basic concepts of sites, 

site collections, site defi nitions, and site templates. To recap, a site collection consists of 

one or more sites, where each site is created by using as a template a site defi nition or a 

customized site defi nition, both of which are commonly known as site templates. 

 The top-level site of a site collection is created when the site collection is created. A site 

collection can be created either by using the browser or programmatically. You cannot 

use SharePoint Designer, however, to create a site collection. You can use SharePoint 

Designer only to create child sites within a site collection. 

See Also To create a site collection, refer to Microsoft Offi ce SharePoint Server 2007 

Administrator’s Companion, by Bill English (Microsoft Press, 2007).

 Microsoft Windows SharePoint Services and Microsoft Offi ce SharePoint Server 

2007 provide a number of built-in site defi nitions that you can use as a basis for the 

SharePoint sites you create. When you use the browser to create a site, these site defi -

nitions are grouped into at least two categories: Collaboration and Meetings. Other 

categories may appear if you have customized site defi nitions or site templates on your 

Web server. 
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The 10 built-in site defi nitions are listed under their respective categories, in the 

following table. 

Collaboration Meeting

Team site Basic Meeting Workspace

Blank site Blank Meeting Workspace

Document Workspace Decision Meeting Workspace

Wiki site Social Meeting Workspace

Blog Multipage Meeting Workspace

SharePoint Server 2007 installs an additional 12 site defi nitions. Some of these site defi -

nitions cannot be used to create sites that are top-level sites of a site collection and 

others can be used only as a template for child sites within a site collection. When you 

use the browser to create a site, these site defi nitions are grouped into two categories: 

Enterprise and Publishing. The following table lists the 12 built-in SharePoint Server site 

defi nitions under their respective categories, and specifi es which you can use to create a 

top-level site collection or use as a basis for a child site of a site collection. 

Enterprise Top-level Child Publishing Top-level Child

Document Center Yes Yes Collaboration Portal Yes No

Records Center Yes Yes Publishing Portal Yes No

Personalization Site No Yes Publishing Site No Yes

Site Directory Yes Yes Publishing Site With 
Workfl ow

No Yes

Report Center Yes Yes

Search Center
with Tabs

Yes Yes

Search Center Yes Yes

My Site Host Yes No

Microsoft has also released an additional 40 site templates for Windows SharePoint 

Services 3.0, known as the “Fabulous 40,” which you can download from the Microsoft 

Download Center and use on both Windows SharePoint Services and SharePoint Server 

installations. Twenty of these site templates use the Blank site defi nition as a basis and 

were customized by using SharePoint Designer. The other 20 are new site defi nitions, 

which include new features. You can use the 40 site templates as well as the built-in site 

templates as a starting point to develop SharePoint-based solutions. 
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Publishing Site Templates

The site defi nitions Report Center, Site Directory, and Search Center with Tabs are 

categorized in the browser as Enterprise site templates; however, they should be 

classifi ed as Publishing site templates as you will create publishing sites if you 

use them. A publishing site is a site that uses the SharePoint Server Web Content 

Management functionality; that is, pages requiring content approval before they 

are visible to a reader of the site. 

See Also For information about publishing sites, see Chapter 11, “Web Content 

Management.”

Publishing functionality is enabled on SharePoint Server sites when the Offi ce 

SharePoint Server Publishing feature is activated. A feature is a new concept 

introduced with Windows SharePoint Services 3.0 that allows you to activate or 

deactivate functionality at a site, site collection, Web application, or SharePoint 

Web farm. The Offi ce SharePoint Server Publishing feature is dependent on the 

activation of the Offi ce SharePoint Server Publishing Infrastructure feature at the 

site collection level. Microsoft developed both these features, which are installed 

when SharePoint Server 2007 is installed on each Web front end. Site owners can 

activate features to extend the functionality of their sites. Therefore, it is possible 

to turn a SharePoint site, based on the team site defi nition, into a publishing site 

by activating the Offi ce SharePoint Server Publishing feature. 

When you create a site by using SharePoint Designer, the site templates are not catego-

rized under the labels Collaboration, Meeting, Enterprise, Publishing, or Custom as they 

are when you use the browser. You cannot confi gure the site’s name, permission inheri-

tance, or whether to use the top link bar from the parent site. Neither can you catego-

rize the new site within the Site Directory, if it is a child site of a Collaboration portal. So, 

after you have created the site in SharePoint Designer, you must remember to confi gure 

these and other site settings by using the browser. 

The fi rst task in developing a SharePoint-based solution when you use SharePoint 

Designer is to create a child site. The only value you need is the URL name, also known 

as the internal name. Use the best practices specifi ed in the sidebar “Best Practices for 

Naming URLs,” on the next page, when you specify the URL name. You cannot use 

SharePoint Designer to create a top-level site of a site collection. 

Publishing Site Templates

The site defi nitionsThe site defi nitions Report CenterReport Center, , rrrr Site DirectorySite Directory, and, andyyyy Search Center with TabsSearch Center with Tabs are are

categorized in the browser as Enterprise site templates; however, they should be categorized in the browser as Enterprise site templates; however, they should be 

classifi ed as Publishing site templates as you will create publishing sites if you classifi ed as Publishing site templates as you will create publishing sites if you 

use them. A publishing site is a site that uses the SharePoint Server Web Content use them. A publishing site is a site that uses the SharePoint Server Web Content 

Management functionality; that is, pages requiring content approval before they Management functionality; that is, pages requiring content approval before they 

are visible to a reader of the site.are visible to a reader of the site.

See AlsoSee Also For information about publishing sites, see Chapter 11, “Web Content 

Management.”

Publishing functionality is enabled on SharePoint Server sites when the Offi ce Publishing functionality is enabled on SharePoint Server sites when the Offi ce 

SharePoint Server Publishing feature is activated. ASharePoint Server Publishing feature is activated. A feature is a new conceptis a new concept

introduced with Windows SharePoint Services 3.0 that allows you to activate or introduced with Windows SharePoint Services 3.0 that allows you to activate or 

deactivate functionality at a site, site collection,deactivate functionality at a site, site collection, Web application, or, or SharePoint 

Web farm. The Offi ce SharePoint Server Publishing feature is dependent on the . The Offi ce SharePoint Server Publishing feature is dependent on the 

activation of the Offi ce SharePoint Server Publishing Infrastructure feature at the activation of the Offi ce SharePoint Server Publishing Infrastructure feature at the 

site collection level. Microsoft developed both these features, which are installed site collection level. Microsoft developed both these features, which are installed 

when SharePoint Server 2007 is installed on each Web front end. Site owners canwhen SharePoint Server 2007 is installed on each Web front end. Site owners can

activate features to extend the functionality of their sites. Therefore, it is possible activate features to extend the functionality of their sites. Therefore, it is possible 

to turn a SharePoint site, based on the team site defi nition, into a publishing site to turn a SharePoint site, based on the team site defi nition, into a publishing site 

by activating the Offi ce SharePoint Server Publishing feature.by activating the Offi ce SharePoint Server Publishing feature.
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Best Practices for Naming URLs

When you specify a Uniform Resource Locator (URL) for a SharePoint object, 

whether it is for a site or a list or library, do not use the following characters: 

\ / : * ? “ < > | # { } % & <TAB> ” ! ~ +

SharePoint Designer will display a Warning dialog box if you use an illegal URL 

character; however, the message does not point specifi cally to the use of one of 

these characters. 

See Also For more information about using these characters in URLs, see the Microsoft 

Knowledge Base article “Information about the characters that you cannot use in sites, 

folders, and fi les in SharePoint Portal Server 2003 or in SharePoint Server 2007,” located 

at support.microsoft.com/kb/905231/.

Keep the name short and meaningful, and include terms that users enter as search 

query keywords. You will not be able to change the URL later. Be consistent in your 

naming conventions; for example, don’t call a picture library pictures in one site 

and images in another. If your aim is to make the URL readable, then use an un-

derscore in place of a space; if the URL consists of several words, capitalize the fi rst 

character in each word. Although the space character is a legal URL character, there 

are several issues with having one or more spaces in the URL, such as the following: 

O Readability. A space in the URL name is URL-encoded as %20. The resulting 

name is diffi cult for people to read. A site with a URL of w s s, would result in an 

encoded version of w%20s%20s, six extra characters. 

 O URL length limitation. A URL must contain no more than 260 total charac-

ters. SharePoint refers to every site, list, library, list item, or document as a URL. 

SharePoint prefi xes the document name by the document library’s URL, which 

is prefi xed by the site’s URL, and then by its parent’s site’s URL, and so on. In ad-

dition, when editing documents or list items, SharePoint appends the URL of 

the document library or list, so that when the user clicks on Save and Close, the 

browser redirects them back to the list or library the item was saved. If the URL 

of the list or library contains two spaces, then it would contain six extra charac-

ters. Then as the URL is appended to the URL for editing, that adds another six 

Best Practices for Naming URLs

When you specify a When you specify a Uniform Resource Locator (URL) for a SharePoint object,for a SharePoint object,

whether it is for a site or a list or library, do not use the following characters:whether it is for a site or a list or library, do not use the following characters:

\ / : * ? “ < > | # { } % & <TAB> ” ! ~ +\ / : * ? “ < > | # { } % & <TAB> ” ! ~ +

SharePoint Designer will display a Warning dialog box if you use an illegal URL SharePoint Designer will display a Warning dialog box if you use an illegal URL 

character; however, the message does not point specifi cally to the use of one of character; however, the message does not point specifi cally to the use of one of 

these characters.these characters.

See AlsoSee Also For more information about using these characters in URLs, see the Microsoft

Knowledge Base article “Information about the characters that you cannot use in sites,

folders, and fi les in SharePoint Portal Server 2003 or in SharePoint Server 2007,” located

at support.microsoft.com/kb/905231///

Keep the name short and meaningful, and include terms that users enter as search Keep the name short and meaningful, and include terms that users enter as search 

query keywords. You will not be able to change the URL later. Be consistent in your query keywords. You will not be able to change the URL later. Be consistent in your 

naming conventions; for example, don’t call a picture library naming conventions; for example, don’t call a picture library picturespictures in one site  in one site 

and and imagesimages in another. If your aim is to make the URL readable, then use an un- in another. If your aim is to make the URL readable, then use an un-

derscore in place of a space; if the URL consists of several words, capitalize the fi rst derscore in place of a space; if the URL consists of several words, capitalize the fi rst 

character in each word. Although the space character is a legal URL character, therecharacter in each word. Although the space character is a legal URL character, there

are several issues with having one or more spaces in the URL, such as the following:are several issues with having one or more spaces in the URL, such as the following:

O Readability.  Readability. A space in the URL name is URL-encoded as %20. The resulting A space in the URL name is URL-encoded as %20. The resulting 

name is diffi cult for people to read. A site with a URL of name is diffi cult for people to read. A site with a URL of w s sw s s, would result in an , would result in an 

encoded version of encoded version of w%20s%20sw%20s%20s, six extra characters., six extra characters.

O URL length limitation. URL length limitation. A URL must contain no more than 260 total charac-A URL must contain no more than 260 total charac-

ters. SharePoint refers to every site, list, library, list item, or document as a URL. ters. SharePoint refers to every site, list, library, list item, or document as a URL. 

SharePoint prefi xes the document name by the document library’s URL, which SharePoint prefi xes the document name by the document library’s URL, which 

is prefi xed by the site’s URL, and then by its parent’s site’s URL, and so on. In ad-is prefi xed by the site’s URL, and then by its parent’s site’s URL, and so on. In ad-

dition, when editing documents or list items, SharePoint appends the URL of dition, when editing documents or list items, SharePoint appends the URL of 

the document library or list, so that when the user clicks on Save and Close, the the document library or list, so that when the user clicks on Save and Close, the 

browser redirects them back to the list or library the item was saved. If the URL browser redirects them back to the list or library the item was saved. If the URL 

of the list or library contains two spaces, then it would contain six extra charac-of the list or library contains two spaces, then it would contain six extra charac-

ters. Then as the URL is appended to the URL for editing, that adds another sixters. Then as the URL is appended to the URL for editing, that adds another six
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characters, making 12 extra characters. Therefore, if you consistently use long 

names, you’ll eventually have problems, which is exaggerated if you use spaces. 

O Links in e-mails. If you incorporate a URL in an e-mail, the e-mail program 

truncates the URL at the fi rst space when sending the clickable link to the recipi-

ent, resulting in a broken link. When users click the link, they are taken to an 

invalid location in the browser and won’t understand why they couldn’t fi nd the 

document. 

In this exercise, you will create two SharePoint sites by using the menu bar and the 

context-sensitive menu. You will also customize the title of a SharePoint site. 

BE SURE TO start SharePoint Designer before beginning this exercise. If a previous site 
opens, click Close Site on the File menu.

USE the teams.consolidatedmessenger.com site as the parent site for the new SharePoint 
team site, or use whatever top-level site you want.

1. On the File menu, click New. 

The New dialog box opens. 

2. Click the Web Site tab. 

Your screen lists three categories of sites: General, Templates, and SharePoint 

Templates. 

BE SURE TO start SharePoint Designer before beginning this exercise. If a previous site start SharePoint Designer before beginning this exercise. If a previous site 
opens, click Close Site on the File menu.opens, click Close Site on the File menu.

USE thethe teams.consolidatedmessenger.comteams.consolidatedmessenger.com site as the parent site for the new SharePointsite as the parent site for the new SharePoint
team site, or use whatever top-level site you want.team site, or use whatever top-level site you want.

characters, making 12 extra characters. Therefore, if you consistently use longcharacters, making 12 extra characters. Therefore, if you consistently use long

names, you’ll eventually have problems, which is exaggerated if you use spaces.names, you’ll eventually have problems, which is exaggerated if you use spaces.

O Links in e-mails.  Links in e-mails. If you incorporate a URL in an e-mail, the e-mail program If you incorporate a URL in an e-mail, the e-mail program 

truncates the URL at the fi rst space when sending the clickable link to the recipi-truncates the URL at the fi rst space when sending the clickable link to the recipi-

ent, resulting in a broken link. When users click the link, they are taken to anent, resulting in a broken link. When users click the link, they are taken to an

invalid location in the browser and won’t understand why they couldn’t fi nd theinvalid location in the browser and won’t understand why they couldn’t fi nd the

document.document.
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3. In the categories list, click SharePoint Templates, if it is not already selected. 

The New dialog box displays no SharePoint Web templates. 

4. Type http://teams.consolidatedmessenger.com/parcels in the Specify the loca-

tion of the new Web site box, and then press F. If prompted, type your user 

name and password, and click OK. 

Tip When you create a site, you must specify a location that uses either Hypertext 

Transfer Protocol (HTTP) or secure HTTP (HTTPS) with Secure Sockets Layer (SSL). 
You cannot specify a fi le system or use File Transfer Protocol (FTP) for the location of 
a SharePoint site. 

 SharePoint Designer communicates with the SharePoint site collection and re-

trieves a list of SharePoint site templates that you can use as a basis for your new 

SharePoint child site. These are displayed in the central pane of the New dialog 

box, also known as the site type list. The SharePoint templates listed are dependent 

on whether you are using Windows SharePoint Services or SharePoint Server, or 

whether your organization has created any site defi nitions. If you connect to an-

other SharePoint site, you may see different SharePoint templates. 
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5. Click Team Site in the site type list, if it is not already selected. 

In the right pane of the New dialog box, the Description section describes the 

purpose of the team site. 

Important After you create a site based on a site template, you cannot change 
the site template it is based on. If the functionality you require is not exposed with a 
SharePoint feature and you choose the wrong site template, you must delete the site 
and create it again. 

6. Click OK. 

The Create New Web Site dialog box opens. 

The dialog box closes after the parcels team site is created. The contents of the par-

cels team site are listed in the Folder List task pane and in the document window 

under the Web Site tab. 
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	 7.	

	 8.	

	 9.	

	 10.	
orking in SharePoint Designer

In the Folder List task pane, right click the URL of the parcels team site, click New, 
and then click Subsite.

The New dialog box opens, with the Web Site tab active. If you display the New 
dialog box when a SharePoint site is open, you can use SharePoint Designer to cre-
ate pages, child sites, and other SharePoint components, such as lists and libraries, 
by using one of the three tabs.

Type http://teams.consolidatedmessenger.com/parcels/boxes in the Specify the 
location of the new Web site box, and then click OK.

A new SharePoint Designer program window opens, with the contents of the boxes 
team site listed in the Folder List task pane and in the document window under the 
Web Site tab.

On the Site menu, click Administration, and then click Administration Home.

A browser window opens and displays the Site Settings page for the boxes team 
site. If prompted, type your user name and password, and then click OK.

Important  Only two links are specified in the Users And Permissions list. This indi-
cates that the boxes team site is inheriting its permissions from its parent site, which 

in this case is parcels. To configure unique permissions, use the browser.

In the Look and Feel list, click Title, description, and icon.



 

D
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The Title, Description, And Icon page appears. The name for the boxes team site is 

Team Site; boxes was used only to form the URL of the team site. To customize the 

site’s title, description, or logo, you cannot use SharePoint Designer but must use 

the browser and the site’s administrator pages. 

11. In the Title text box, type Boxes Department, and then click OK. 

The Site Settings page opens. 

CLOSE SharePoint Designer and all browser windows.

eleting a SharePoint Site
If you no longer need or want a site then you can delete it. However, be warned—when 

you delete a site, it is not sent to the Recycle Bin. As we have seen earlier in this chapter, 

when you create a site by using SharePoint Designer, the title of the site is the name of 

the site template used to create the site. Therefore you could end up with many sites 

named Team Site, and it is only by looking at their URLs that you will be able to see 

which site they are, so always verify that you are deleting the correct site. 

In this exercise, you will navigate from one SharePoint site to another site and delete a 

SharePoint site. 

BE SURE TO start SharePoint Designer before beginning this exercise.

USE the sites created in the previous exercises.

1. On the File menu, point to Recent Sites, and then click http://teams.consolidat-

edmessenger.com/parcels. If prompted, type your user name and password, and 

then click OK. 

The Folder List task pane displays the contents of the parcels team site and the 

boxes child site. Notice that the Folder List task pane displays the URL of the child 

site, rather than the title. 

BE SURE TO start SharePoint Designer before beginning this exercise.start SharePoint Designer before beginning this exercise.

USE the sites created in the previous exercises.the sites created in the previous exercises.
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2. Double-click the boxes child site. 

A new SharePoint Designer program window opens with the contents of the boxes 

team site listed in the Folder List task pane and in the document window under the 

Web Site tab. 

Tip You can customize only one site within each SharePoint Designer program win-
dow; however, when you have multiple SharePoint Designer program windows open, 
it is very easy to customize the wrong site. Therefore, customize one site at a time, 
and close all other SharePoint Designer program windows. 

3. Right-click the boxes URL in the Folder List task pane, and click Delete. 

The Confi rm Delete dialog box opens. 

4. Click Delete this Web site entirely, and then click OK. 

The SharePoint Designer program window opens with no site open. 

5. Return to the SharePoint Designer program window that displays the contents of 

the parcels team site. 

The boxes child site no longer appears in the Folder List task pane. 

Tip If the boxes child site is still visible, click Refresh on the View menu. 

Warning You cannot delete the top-level site of a site collection by using SharePoint 
Designer, nor can you delete a site that still contains child sites. If you try to do this, 
SharePoint Designer displays a warning. 

CLOSE all SharePoint Designer program windows. If you’re not continuing directly to the 
next chapter, exit SharePoint Designer.
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Key Points
O By default, SharePoint Designer remembers the last site you worked on and opens 

it when you start the program, but you can alter this setting on the General tab of 

the Application Options dialog box. 

O The contents of the SharePoint site are listed in the Folder List task pane and on the 

Web Site tab in the document window. When you double-click a fi le in the Folder 

List task pane, the default editor is used to open the fi le. The default editor is speci-

fi ed on the Confi gure Editors tab of the Application Options dialog box. 

O SharePoint Designer uses the security Internet Properties settings of your browser 

to decide whether to prompt for credentials. 

O SharePoint Designer provides 12 built-in toolbars and 24 task panes that provide 

you with visual ways of manipulating elements on your pages. 

O New to Windows SharePoint Services 3.0 is the concept of a feature: some can be 

activated at the site-collection level, whereas others can be activated on a site-by-

site basis. 

O You cannot change the site template that is used to create a SharePoint site after it 

is created. If the functionality you require is not exposed by a feature, you will have 

to delete the SharePoint Site and re-create it based on a different site template. 

O URLs should not contain the characters \ / : * ? “ < > | # { } % & <TAB> ” ! ~. Nor 

should they contain spaces because these are encoded as %20. URLs must be fewer 

than 260 characters. 

O You can delete child sites of a site collection by using SharePoint Designer; how-

ever, you cannot delete the top-level site of a site collection. Deleted sites are not 

sent to the Recycle Bin. 
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  Modifying   Modifying 
  Web Pages  Web Pages

In this chapter, you will learn to:

� Create a Basic Meeting Workspace site.

� Create a Web Part page by using a browser.

� Create an ASP.NET page.

� Insert a Web Part zone.

� Add a Web Part and modify Web Part properties.

� Attach a master page.

� Create a Web page from a master page.

� Delete a Web page.

With Microsoft Offi ce SharePoint Designer 2007, you can create a number of different fi le 

formats, some of which you may not consider to be pages; for example, text and cascading 

style sheet fi les, and others you may not have heard about before reading this book. 

In Chapter 3, “Customizing a Web Page,” you learned how to customize a nonpublishing 

page, which merges together a master page and a content page. In particular, you inves-

tigated the home page of a SharePoint team site. 

In this chapter, you’ll investigate the differences between pages on the SharePoint team 

site and a Basic Meeting Workspace site, and how to create content pages for both 

collaboration and Meeting Workspace sites by using SharePoint Designer. In this chapter, 

you will use both the browser and SharePoint Designer to create Web Part pages. You’ll 

learn that Web Part pages are just Microsoft ASP.NET 2.0 content pages and that any 

SharePoint content page can contain one or more Web Parts. You’ll also learn how to 

change the appearance of pages by adding and removing Web Part zones, the contain-

ers for Web Parts, as well as adding and removing Web Parts. 
   77
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Important No practice fi les are required to complete the exercises in this chapter. For 
more information about practice fi les, see “Using the Book’s CD” at the beginning of this 
book. 

Troubleshooting Graphics and operating system–related instructions in this book 
refl ect the Windows Vista user interface. If your computer is running Windows XP and you 
experience trouble following the instructions as written, please refer to the “Information for 
Readers Running Windows XP” section at the beginning of this book. 

Creating a Basic Meeting Workspace Site
In Chapter 2, “Working in SharePoint Designer,” you created a site hierarchy by using the 

team site defi nition, and in Chapter 3, you explored the home page of a team site. Before 

we create a new page, we are going to explore a different-looking SharePoint page, the 

home page of a SharePoint Basic Meeting Workspace site. The Meeting Workspace does 

not contain a Quick Launch bar and uses a second row of tabs, called Pages, which you 

can manipulate in the browser by using the Add Pages and Manage Pages options on 

the Site Action menu. These additional pages are stored in a hidden document library 

called pages (Workspace pages). 

Tip Don’t confuse the pages (Workspace pages) document library on a meeting workspace 
site with the Pages document library on a publishing site, which is not hidden and is Web 
Content Management–enabled. They are completely different document libraries, and do 
not share the same functionality. 

Using the browser, you can add only 10 of these Meeting Workspace pages before a 

message is displayed stating that you have reached the maximum number of pages for 

the workspace and that you must delete a page before a new one can be added. This 

is a limitation of the browser interface; you can create additional Meeting Workspace 

pages by using SharePoint Designer. 

Before you create a Meeting Workspace page, as with any site, you must familiarize 

yourself with that site. 

Both the team site home page and the Basic Meeting Workspace home page are ASP.

NET 2.0 content pages but associated with different master pages. When you opened 

the team site home page in Chapter 2, the name of the master page was default.master, 

whereas sites based on Meeting Workspace site defi nitions use a master page named 

MWSDefault.master. 

Troubleshooting Graphics and operating system–related instructions in this bookGraphics and operating system–related instructions in this book
refl ect the Windows Vista user interface. If your computer is running Windows XP and yourefl ect the Windows Vista user interface. If your computer is running Windows XP and you
experience trouble following the instructions as written, please refer to the “Information forexperience trouble following the instructions as written, please refer to the “Information for
Readers Running Windows XP” section at the beginning of this book.Readers Running Windows XP” section at the beginning of this book.
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The team site home page and the Basic Meeting Workspace home page have a main 

content region, PlaceHolderMain, which contains Web Part zones and Web Parts. How-

ever, the Meeting Workspace contains the following two additional regions in which you 

can add content: 

O The PlaceHolderLeftNavBar content region, which is located to the left of the page 

(where the Quick Launch bar is situated on a team site). This region includes a Web 

Part zone labeled MeetingNavigator that contains the Meeting Series List View 

Web Part (LVWP). 

O The PlaceHolderTitleInTitleArea content region, which includes a Web Part zone la-

beled Meeting Summary, that also contains an instance of the Meeting Series LVWP. 

In this exercise, you will create a Basic Meeting Workspace site by using SharePoint 

Designer, and you will then explore the home page. 

Note Creating a Meeting Workspace by using SharePoint Designer does not tie it directly 
to any event; therefore, the Meeting Series LVWP does not display any data. If you create a 
Meeting Workspace by using Microsoft Offi ce Outlook or from a Calendar Event, the two 
LVWPs contain a link for each meeting event. 

USE the SharePoint team site, or whatever team site you want.

BE SURE TO start SharePoint Designer before beginning this exercise.

OPEN the site in SharePoint Designer, and close any pages that might be open in the 
document window.

 1. On the Common toolbar, click the New Document arrow, and then in the list, click 

Web Site. 

The New dialog box opens. 

USE the SharePoint team site, or whatever team site you want.the SharePoint team site, or whatever team site you want.

BE SURE TO start SharePoint Designer before beginning this exercise.start SharePoint Designer before beginning this exercise.

OPEN the site in SharePoint Designer, and close any pages that might be open in thethe site in SharePoint Designer, and close any pages that might be open in the
document window.document window.

New DocumentNew Document
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2. In the left-most pane of the New dialog box, click SharePoint Templates if it is not 

already selected, and then click Basic Meeting Workspace. 

Note As SharePoint Designer retrieves a list of site defi nitions from the Web server 
for this particular site collection, you may be prompted for your user name and pass-
word. The list of site defi nitions returned depend on how the server administrator has 
confi gured your installation. You may see a different site defi nitions, especially if you 
modify a number of sites within a different of site collections.  

3. In the Specify the location of the new Web site text box, type 

http://teams.consolidatedmessenger.com/meetings

and then press F. If prompted, type your user name and password, and click OK. 

The Create New Web Site dialog box briefl y appears and then a new SharePoint 

Designer program window opens displaying the meetings child site. The title of the 

site is taken from the name of the site template. 

4. In the Folder List task pane, double click default.aspx. 

The home page of the meetings site opens as a second tab in the document window. 

Content regions
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As with the team site home page, the main content of the page is held within the 

PlaceHolderMain (Custom) content region, which for this home page contains three 

Web Part zones denoted by two blue borders, labeled at the top as Left, Center, and 

Right. The relative address of the master page is listed in the upper-right corner of 

the page. 

5. In the Folder List task pane, right-click pages (Workspace Pages), and then click 

Properties. 

The Document Library Properties dialog box opens. 

6. Click the Settings tab of the Document Library Properties dialog box, and notice 

that the Hide from browsers check box is selected. 

Tip To administer the Workspace Pages document library you need to access the 
library’s Settings page. Click the Security tab, and then click Manage Permissions 
Using The Browser. On the breadcrumb of the Permissions page that opens, click 
Settings. The Customize Workspace Pages page opens, from which you can manage 
the settings for this document library. 

CLOSE the meeting site and the browser.

See Also For more information about creating Meeting Workspaces, see Chapter 8, “Working 

with Meeting Workspaces,” and Chapter 11, “Using Windows SharePoint Services with 

Outlook 2007,” of Microsoft Windows SharePoint Services 3.0 Step by Step by Olga Londer, Bill 

English, Todd Bleeker, and Penelope Coventry (Microsoft Press, 2007). 
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Creating a Web Part Page by Using a Browser
When a SharePoint site is created, it contains a number of page, most of which contain 

Web Parts. You can create additional pages, known as Web Part Pages. You can only use 

the browser to create Web Part Pages, and when you create these pages they are stored 

and accessed via document libraries. 

When you use SharePoint Designer to create an ASP.NET page, you are not limited to 

storing them in a document library; as you will see later in this chapter, you can store 

pages in the root of the site or in a folder. However, if you plan to create a large number 

of pages, you should create a document library specifi cally for this purpose. You can use 

this document library to store both the pages you create using SharePoint Designer and 

those you create using the browser. Then users who need to access or customize the 

pages by using the browser do not need to know which method you used to create the 

pages, and you can use the document management features of SharePoint to manage 

the pages. 

When you create Web Part Pages, you use one of eight built-in Web Part Page templates 

stored on each Web server as a basis. Web Part Pages are ASP.NET pages associated with 

a master page and pre-populated with a number of empty Web Part zones, each 

with a unique name. Each template has a different column and zone layout so that you 

can choose the one that best suits your needs. When you create a page based on one 

of these Web Part Page templates, you create an un-customized page; that is, no page 

is stored in the Microsoft SQL Server content database—there is simply a pointer to the 

Web Part Page template on the fi le system. 

Each template contains one Web Part that you can modify to display a title, caption, de-

scription, and icon. You can you add one or more Web Parts to one or more zones that 

the template contains as you modify the page. Information concerning Web Parts 

that you add to Web Part zones and their properties is stored in the SQL Server content 

database, but in a separate table from the table, that stores the page. Therefore, when 

you insert or modify a Web Part, the page can still point to the Web Part Page template 

in the TEMPLATE folder on the Web server. (This is true for any page created from a site 

defi nition fi le.) 

SharePoint Designer does not provide a separate method of saving Web Part modifi ca-

tions; you have to save the page for SharePoint Designer to save the modifi cations to 

the Web Part. Saving the page results in a customized page, even though you have not 

modifi ed the page’s static content. If you do not want to save the page in the SQL Server 

content database (that is, if you want your page to remain an un-customized page), you 

can use the Revert To Site Defi nition option without losing any Web Part modifi cations. 
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In the following exercise, you will create a document library in which to store Web Part 

pages. You will also create a Web Part page and modify Web Part properties. 

USE the SharePoint team site you modifi ed in the previous exercise.

OPEN the SharePoint site in a browser.

Important In this exercise, you need a site created from the team site template. Do not 
use a site pages on a Meeting Workspace site template. 

1. Click Site Actions, and then click Create. 

The Create Page Web page is displayed. 

2. Under Libraries, click Document Library. 

The New page is displayed. 

3. In the Name text box, type WebPages. 

Tip The name that you type in the Name text box is used to create the URL, as well 
as the title of the document library and title of the page. For details about good nam-
ing conventions, see the sidebar “Best Practices for Naming URLs” in Chapter 2. 

4. In the Document Template area, in the Document template list, click Web Part Page. 

5. At the bottom of the page, click the Create button. 

The All Documents view of the new Web Part Pages document library is displayed. 

6. Click the New button. 

The New Web Part Page page is displayed. 

7. In the Name text box, type WebShipping. 

8. In the Layout area, in the Choose a Layout Template list, click Header, Right 

Column, Body, and at the bottom of the page, click Create. 

The new Web Part page is displayed with three distinct Web Part zones: Header, 

Body, and Right Column. The page is empty except for the top link bar, the bread-

crumb, and the Site Actions link. No Web Parts are placed within the Web Part 

zones. 

9. Open the teams.consolidatedmessenger.com team site in SharePoint Designer. In the 

Folder List task pane, expand the WebPages document library to display its contents.

USE the SharePoint team site you modifi ed in the previous exercise.the SharePoint team site you modifi ed in the previous exercise.

OPEN the SharePoint site in a browser.the SharePoint site in a browser.
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WebShipping.aspx should appear. 

10. Double-click WebShipping.aspx. 

The WebShipping page opens in the document window. The main PlaceHolderMain 

content region contains the Header, Body, and Right Column Web Part zones. The 

PlaceHolderPageTitleInTitleArea content region contains a fourth Web Part zone 

labeled TitleBar, which includes the Web Part Page Title Bar Web Part. 

Tip If you cannot see the names of the content regions, verify that Visual Aids are on 
and the Template Region Labels option on the Visual Aids menu is selected. 

11. In the Web Part Page Title Bar Web Part, right-click WebShipping, and then click 

Web Part Properties. 

The Web Part Page Title Bar dialog box opens. 

12. In the Title text box, place the cursor between Web and Shipping and press 

S, then click OK. 

The dialog box closes, and an asterisk appears on the WebShipping.aspx tab. 

Tip In the browser, you can modify the Web Part Page Title Bar Web Part by clicking 
the Edit Title Bar Properties link when the page is in Edit mode. 

13. On the Common toolbar, click the Save button. 

SaveSave
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The Site Defi nition Page Warning dialog box opens, stating that saving your changes 

will customize a page from the site defi nitions. 

 14. Click Yes. 

The dialog box closes, and in the Folder List task pane, a blue information circle 

appears to the left of WebShipping.aspx. 

 15. In the Folder List task pane, right-click WebShipping.aspx, and then click Reset to 

Site Defi nition. When the Site Defi nition Page Warning dialog box appears, click Yes. 

In the Folder List task pane, the blue information icon to the left of WebShipping 

disappears and WebShipping_copy.aspx appears with a blue information icon. The 

WebShipping.aspx page in the document window refreshes, showing that your 

modifi cation to the Web Part properties remain. 

CLOSE the WebShipping.aspx page.

Creating an ASP.NET Page
All built-in Web Part Pages consist of an ASP.NET page with Web Part zones. If you 

want to create a Web Part page similar to the ones created using the browser, then in 

SharePoint Designer, you could copy an existing page, as you did in Chapter 3, or you 

need to create an ASP.NET page, associate a master page and insert Web Part zones 

and Web Parts, using as many Web Part zones as you want in the layout of your choice. 

All built-in Web Part Pages use tables, but if you are concerned about accessibility, you 

may want to use tables of HTML <div> tags to lay out the pages you create from scratch. 

Because you can insert more than one Web Part per Web Part zone, it is common prac-

tice to insert one Web Part zone to a table cell or <div> tag. 

See Also For more information about page accessibility, see Chapter 15, “Understanding 

Usability and Accessibility.”

In this exercise, you will create a new ASP.NET page with a table layout. 

USE the SharePoint team site you modifi ed in the previous exercise.

OPEN the site in SharePoint Designer, if it is not already open.

USE the SharePoint team site you modifi ed in the previous exercise.the SharePoint team site you modifi ed in the previous exercise.

OPEN the site in SharePoint Designer, if it is not already open.the site in SharePoint Designer, if it is not already open.
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 1. On the Common toolbar, click the New Document button. 

A new fi le named Untitled_1.aspx opens. 

 2. On the Common toolbar, click the Save button. 

 The Save As dialog box opens. 

  3. Double-click WebPages. In the File name text box, type ParcelDelivery.aspx. 

  4. Click Change title. 

 The Set Page Title dialog box opens. 

 5. If prompted, type your user name and password, and then click OK. 

 6. In the Page title text box, type Consolidated Messenger Parcel Delivery. 

 7. Click OK to close the Set Page Title dialog box, and then click Save to close the 

Save As dialog box. 

  8. On the Table menu, click Layout Tables. 

 The Layout Tables task pane appears in the lower left of the SharePoint Designer 

program window. 

  9. In the Layout Tables task pane, under Table layout, scroll down and click Header, 

Body, Footer, and Right. 

New DocumentNew Document

SaveSave
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Table markers appear in the page body, designating a table 635 (525+110) pixels 

wide by 611 (83+472+56) pixels high. The green lines indicate the outer edge of the 

table, and the internal blue lines indicate the cell layout of the table. 

Inserting a Web Part Zone
With Web Part zones, users can manipulate the content of a page by using a browser. 

You can insert Web Part zones into ASP.NET pages. If an ASP.NET page is associated with 

a master page, and therefore would be classifi ed as a content page, then Web Part zones 

can be inserted only into content regions on such content pages. You cannot insert Web 

Part zones into master pages. Developers or Web designers can use Microsoft Visual 

Studio 2005 to defi ne Web Part zones in pages stored in the 12 hive on a Web server; or 

you can use SharePoint Designer to insert a Web Part zone into a new or existing page 

and then save the page in the SQL Server content database. 

You can insert only Web Parts into Web Part zones; you cannot insert text or images. 

Web Part zones have properties that affect the presentation of the Web Parts they con-

tain, and they control the actions users are allowed to perform using the browser. These 

properties are detailed in the table on the next page. 
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Web Part zone 

property

Description

Zone title Used when storing Web Part information in the SQL Server content da-
tabase. You should give each zone a meaningful and consistent title; for 
example, don’t name the Web Part zone in a left cell First on one page 
and Left on another. This is particularly important if you create Web 
Part zones on page layouts in publishing sites.

 Frame Style The default frame style for all Web Parts in the zone. This setting can 
be overridden by the Web Part Frame Style property.

 Layout of Web 
Parts contained in 
the zone

Allows you to choose between Top-To-Bottom (Vertical Layout) or 
Side-By-Side (Horizontal Layout).

 Browser settings 
for Web Parts con-
tained in the zone

Allows you to restrict the modifi cation of the page by browser users. 
By clearing the three check boxes, you effectively remove the ability to 
customize any Web Parts placed in the zone by using the browser.

In this exercise, you will insert two Web Part zones. 

USE the SharePoint team site you modifi ed in the previous exercise.

OPEN the site in SharePoint Designer, if it is not already open, and display the page on 
which you would like to insert a Web Part zone.

1. Position the insertion point in the top cell. 

Tip To see the table cells, turn on Visual Aids: on the View menu, point to Visual Aids 
and click Show. 

2. On the Insert menu, point to SharePoint Controls, and then click Web Part Zone. 

A Web Part zone labeled Zone 1 appears in the top cell, and an orange tag, named 

webpartpages:webpartzone, appears in the Quick Tag Selector. 

USE the SharePoint team site you modifi ed in the previous exercise.the SharePoint team site you modifi ed in the previous exercise.

OPEN the site in SharePoint Designer, if it is not already open, and display the page on the site in SharePoint Designer, if it is not already open, and display the page on 
which you would like to insert a Web Part zone.which you would like to insert a Web Part zone.
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 3. Right-click Zone 1, and then click Web Part Zone Properties. 

The Web Part Zone Properties dialog box opens. 

 4. In the Zone title text box, type Header, click Side-by-side (horizontal layout), and 

then below Browser settings for Web Parts contained in the zone, clear the three 

check boxes. 

  5. Click OK to close the Web Part Zone Properties dialog box. 

  6. Position the insertion point in the left cell under the header cell. Then on the Insert 

menu, point to SharePoint Controls, and click Web Part Zone. 

  7. Double-click Zone 1 to open the Web Part Zone Properties dialog box. In the 

Zone title text box, type Left. 

  8. Click OK to close the Web Part Zone Properties dialog box. 

  9. On the Common toolbar, click the Save button. 

SaveSave
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Adding a Web Part and Modifying 
Web Part Properties

Managing Web Parts in SharePoint Designer is very similar to managing Web Parts by 

using the browser. In the browser, when you edit a page and add a Web Part, you can 

choose the Advanced Web Part Gallery And Options to open the Add Web Parts tool 

pane. SharePoint Designer has a similar interface: the Web Parts task pane. The only 

difference is that, in the browser, you are presented with three galleries, whereas in 

SharePoint Designer, you see only two because Closed Web Parts are displayed on the 

page as an opaque image, instead of being listed in the Closed Gallery as they are in 

the browser. (A Web Part gallery is a collection of Web Parts.) 

Adding a Web Part 

 in the browser

Closed Web Part Adding a Web Part in  

SharePoint Designer

In SharePoint Designer, the two galleries are as follows: 

O [site name] Gallery. In our example, this is Teams Gallery. The number of Web 

Parts listed in the [site name] Gallery varies based on the defi nition of the site and 

the features that are activated on that site. The Web Parts listed in this gallery can 

be managed at the site collection level, where it is known as the Web Part Gallery.  

O Server Gallery. This gallery contains Web Parts that a SharePoint Administrator has 

added to the server farm by using the command-line tool stsadm. This gallery is 

sometimes referred to as the central Web Part Gallery. 
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The Web Parts in the galleries act as templates from which you create instances of these 

Web Parts on your page. The template of the Web Part remains in the galleries for you 

to use again. You can confi gure each instance of a Web Part differently; in fact, as soon 

as you add an instance of a Web Part to a page, you should alter the title of the Web 

Part to refl ect its use. 

You can add the same Web Parts to a page by using either SharePoint Designer or the 

browser. There are two types of Web Parts: 

O List View Web Parts (LVWPs). Web Parts that display the contents of lists and 

libraries. Each time the data within the list or library changes, the changes are re-

fl ected in the LVWP. You will see LVWPs for lists and libraries for the site you have 

open in SharePoint Designer, and you will see LVWPs for lists or libraries created in 

other sites. 

O Built-in Web Parts. A Microsoft Windows SharePoint Services 3.0 installation has 

eight built-in Web Parts: Content Editor Web Part (CEWP), Form Web Part, Image 

Web Part, Page Viewer Web Part, Relevant Documents, Site Users, User Tasks, and 

XML Web Part. Microsoft Offi ce SharePoint Server 2007 includes more than 50 ad-

ditional built-in Web Parts, including Business Data List, Content Query Web Part 

(CQWP), Current User Filter, Excel Web Access, Key Performance Indicators, Search 

Box, and SQL Server 2005 Analysis Services cubes. A detailed description of these 

Web Parts is outside the scope of this book. 

See Also For more information about Web Parts, see Chapter 29, “Microsoft Offi ce 

SharePoint Server 2007 Web Parts,” in Microsoft Offi ce SharePoint Server 2007 Administrator’s 

Companion, Bill English, 2007.

Using SharePoint Designer, you can also create a Data View Web Part (DVWP), also 

known as a Data Form Web Part (DFWP), which you can use to display and modify lists 

and libraries, as well as other data sources.  

See Also For more information about the Data View Web Part, see Chapter 6, “Working with 

Data Views.”
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Web Parts are further classifi ed by their location, as follows: 

O Dynamic Web Parts. These Web Parts are placed in Web part zones by using either 

SharePoint Designer or the browser. (When using the browser, you can add Web 

Parts only to Web Part zones.) Dynamic Web Parts are stored separately from the 

page, and only when a user requests the page is the SQL Server content database 

queried to fi nd out the number of dynamic Web Parts, what they are, and in which 

Web Part zone they should be placed. They are then merged with the master page 

and content page. 

O Static Web Parts. These Web Parts are placed outside of Web Part zones by using 

SharePoint Designer. They cannot be customized by using the browser. Static Web 

Parts are stored as part of the page and can be added to both master pages and 

content pages. 

In this exercise, you will add, modify, and delete a Web Part. 

USE the SharePoint team site you modifi ed in the previous exercise.

OPEN the site in SharePoint Designer, if it is not already open, and display the 
ParcelDelivery.aspx page.

 1. In the Header Web Part zone, click Click to insert a Web Part. 

The Web Parts task pane opens. 

 2. Point to the icon to the left of the Image Web Part. You may need to click the Next 

link in the Web Parts task pane if you cannot see the Image Web Part. 

The mouse pointer changes to a four-headed arrow. 

 3. Drag the Web Part to the Header Web Part zone. 

As you move the Web Part, the pointer changes to an arrow with a plus sign (+) 

enclosed in a square. SharePoint Designer redisplays the page with the Image Web 

Part placed in the Header Web Part zone. 

 4. Double-click the Image Web Part to open the Image Web Part dialog box. 

 5. In the text box below Image Link, type /_layouts/images/homepage.gif, and in 

the Alternative Text text box, type Consolidated Messenger Teams logo. 

USE the SharePoint team site you modifi ed in the previous exercise.the SharePoint team site you modifi ed in the previous exercise.

OPEN the site in SharePoint Designer, if it is not already open, and display the the site in SharePoint Designer, if it is not already open, and display the 
ParcelDelivery.aspxParcelDelivery.aspx page.page.xx

Four-Way Arrow 
Pointer

Four-Way Arrow 
Pointer

Add PointerAdd Pointer
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Tip You do not have to type the URL of the image fi le. You can click the ellipsis but-
ton below Image Link to open the Edit Hyperlink dialog box, from which you can 
navigate to the image fi le that you want to use. 

6. Expand the Appearance section. Then in the Title text box, type Teams Logo. 

7. Click OK to close the Image Web Part dialog box. 

The Image Web Part displays the Microsoft Windows SharePoint Services logo. 

8. Drag a second Image Web Part on top of the fi rst Image Web Part. 

The two Web Parts should display side by side. 

9. Click the Left Web Part zone. In the Web Parts task pane, click Content Editor Web 

Part. Then at the bottom of the Web Parts task pane, click Insert Selected Web Part. 
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 10. In the Content Editor Web Part, select the text To add content, select this text 

and replace it by typing or inserting your own content, type Consolidated 

Messenger is one of the leading courier and parcel delivery services, and then 

press F to move to a new line. 

 11. Select the sentence you just typed, and on the Common toolbar, in the Styles list, 

click Heading 3.

 12. On the Common toolbar, click the Center alignment button. 

Tip You can use the Common toolbar buttons and Design view to edit the contents 
of the Content Editor Web Part in a WYSIWYG manner. To enter HTML source code or 
JavaScript, use Code view. 

 13. Right-click the Content Editor Web Part, and then click Web Part Properties to 

open the Content Editor Web Part dialog box. 

 14. Expand the Appearance section, and in the Title text box, type Who Are We. 

 15. In the Chrome Type list, click None. 

CenterCenter
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 16. Click OK to close the Content Editor Web Part dialog box. 

 17. On the Common toolbar, click the Save button, and then press |. If prompted, 

type your user name and password, and click OK. 

 A browser window opens, with Consolidated Messenger Parcel Delivery in the 

program window title bar and displaying the ParcelDelivery.aspx page. There is no 

SharePoint look and feel to the page. 

CLOSE the browser.

Attaching a Master Page
 In the previous exercises, you created an ASP.NET page and added Web Part zones and 

Web Parts to it, but it did not contain any SharePoint site navigation nor did it inherit any 

look and feel from the SharePoint site. You can envisage the page we created as just the 

content page. It is not associated with a master page, which is the page that defi nes 

the common user interface and code. 

SaveSave
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In this exercise, you will attach a master page to an existing page. 

USE the SharePoint team site you modifi ed in the previous exercise.

OPEN the site in SharePoint Designer, if it is not already open, and display the 
ParcelDelivery.aspx page.

1. On the Format menu, point to Master Page, and then click Attach Master Page. 

The Select A Master Page dialog box opens. 

2. In the Select a Master Page dialog box, click Default Master Page (~masterurl/

default.master). 

3. Click OK to open the Match Content Regions dialog box. 

USE the SharePoint team site you modifi ed in the previous exercise.the SharePoint team site you modifi ed in the previous exercise.

OPEN the site in SharePoint Designer, if it is not already open, and display the the site in SharePoint Designer, if it is not already open, and display the 
ParcelDelivery.aspxParcelDelivery.aspx page.page.xx
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 4. Click OK to accept the default of associating all the code within the HTML 

body tags of the current page, ParcelDelivery.aspx, to the content region, 

PlaceHolderMain on the master page. 

SharePoint Designer redisplays ParcelDelivery.aspx, which now has a SharePoint 

look and feel. 

 5. On the Common toolbar, click the Save button and then press | to review the 

page in the browser. 

 Tip If you have a site based on HTML or ASPX pages, you can convert the site into 
a SharePoint site by copying the pages into libraries, folders, or the root directory 
of a SharePoint site. Then rename any fi les that have an HTM or ASP extension to 
ASPX, and attach the master page to them as described in this exercise. 

CLOSE the browser.

SaveSave
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Creating a Web Page from a Master Page
You can use several different methods to create an ASP.NET page within SharePoint 

Designer. However, because the page will be part of a SharePoint site, you will most 

likely want to keep the same navigation elements and look and feel as other pages. This 

is achieved by linking the content page with a master page. In Chapter 3, you created 

a new ASP.NET page by copying an existing page that is associated with a master page 

and then customizing it. In this chapter, you fi rst created an ASP.NET page by using the 

browser, which again is automatically associated with a master page, and then in the 

previous exercise, you attached a master page to an ASP.NET page. 

You can also create a content page from a master page. As we have seen in previous 

exercises, most customizations, Web Part zones, and Web Parts are stored within one 

or more content regions. When you create a content page from a master page, you 

can’t make any changes to the content regions. To make changes to the content, you must 

make the content regions editable. 

In this exercise, you will create a content page from a master page and then make the 

PlaceHolderMain content region editable. 

USE the SharePoint team site you modifi ed in the previous exercise.

OPEN the site in SharePoint Designer, if it is not already open, and close any pages or task 
panes that are open in the document window.

 1. In the Folder List task pane, expand the _catalogs folder, and then expand the 

masterpage (Master Page Gallery) document library to display its contents. 

The default.master fi le should appear. 

 2. Right-click default.master, and then click New from Master Page. 

USE the SharePoint team site you modifi ed in the previous exercise.the SharePoint team site you modifi ed in the previous exercise.

OPEN the site in SharePoint Designer, if it is not already open, and close any pages or taskthe site in SharePoint Designer, if it is not already open, and close any pages or task
panes that are open in the document window.panes that are open in the document window.
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A new fi le, with a tab label of Untitled_1.aspx, appears in the document window. An 

asterisk to the right of the label name indicates that the page is not yet saved. 

 3. Right-click the untitled_1.aspx tab, and then click Save. 

The Save As dialog box opens showing the teams.consolidatedmessenger.com site 

contents. 

 4. In the File name text box, type ShippingAdvice.aspx, and then click Save. 

The tab is renamed to ShippingAdvice.aspx, and in the Folder List task pane, the fi le 

appears in the root of the site. 

 5. On the View menu, point to Toolbars, and then click Master Page to open the 

fl oating Master Page toolbar. 

 6. On the Master Page toolbar, click the Regions arrow, and then in the list, click 

PlaceHolderMain. 

The PlaceHolderMain (Master) content region on the ShippingAdvice.aspx page is 

highlighted. 

 7. Close the Master Page toolbar. 

 8. Click the chevron to the right of the PlaceHolderMain content region, and in the 

Common Content Tasks list, click Create Custom Content. 

The content region is renamed PlaceHolderMain (Custom), thereby making this 

content region editable. You can now insert text, Web Part zones, and Web Parts 

into this area of the ShippingAdvice.aspx content page. 

 9. Click the Save button. 

ChevronChevron

SaveSave
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Deleting a Web Page
As you develop your solutions and experiment with SharePoint Designer, you will 

create pages that after some time you will no longer need. SharePoint Designer, like 

other Microsoft Offi ce products, allows you to easily delete a page when you no lon-

ger need it. 

In this exercise, you will delete a page and then restore it from the Recycle Bin. 

USE the SharePoint team site you modifi ed in the previous exercise.

OPEN the site in SharePoint Designer, if it is not already open, and display the 
ShippingAdvice.aspx page.

 1. In the Folder List task pane, right-click ShippingAdvice.aspx, and then click Delete. 

The Confi rm Delete dialog box opens. 

 2. Click Yes to close the Confi rm Delete dialog box. 

ShippingAdvice.aspx is no longer listed in the root of the site. 

 3. On the Site menu, click Recycle Bin. 

A browser window opens and displays the Recycle Bin for the team site. 

 4. If prompted, type your user name and password, and then click OK. 

 5. Select the ShippingAdvice.aspx check box, and then click Restore Selection. 

USE the SharePoint team site you modifi ed in the previous exercise.the SharePoint team site you modifi ed in the previous exercise.

OPEN the site in SharePoint Designer, if it is not already open, and display the the site in SharePoint Designer, if it is not already open, and display the 
ShippingAdvice.aspxShippingAdvice.aspx page.page.xx
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 6. Click OK in the Windows Internet Explorer dialog box. 

The Recycle Bin page is redisplayed, where ShippingAdvice.aspx is no longer listed. 

 7. Return to SharePoint Designer, and press %. 

In the Folder List task pane, ShippingAdvice.aspx is listed. 

CLOSE the browser windows. If you’re not continuing directly to the next chapter, exit 
SharePoint Designer.

Key Points
O The Meeting Workspace uses a master page, named MWSDefault.master, and 

stores pages in a hidden document library named pages (Workspace pages). 

O In the browser, you can create a Web Part Page based on one of the eight built-in 

Web Part Page templates. 

O In SharePoint Designer, you can create an ASP.NET page and then attach a master 

page to give it the look and feel of the SharePoint site. 

O You can create a content page from a master page, but you can add content to the 

page only if you make at least one PlaceHolderMain content region editable. 

O Web Part zones can be inserted only in content regions on content pages; they 

cannot be inserted on master pages. 

O There are two types of Web Parts: List View Web Parts and built-in Web Parts. List 

View Web Parts display the contents of SharePoint lists and libraries. 

O Web Parts can be inserted outside Web Part zones on content pages and master 

pages on by using SharePoint Designer. These are known as static Web Parts. 

O Web Parts inserted into Web Part zones are known as dynamic Web Parts. Details 

of dynamic Web Parts are stored in the SQL Server database separate from content 

pages and master pages. 

O Any pages or fi les you delete in SharePoint Designer are stored in the Recycle Bin, 

from which you can restore them. 
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documents, 339-341

lists and libraries, 336-339

copyright issues, 351

core workfl ow actions, 285, 360

core.css fi le, 230. See also inheritance in CSS

Create List Item action, 362

Created by a specifi c person (condition), 359

Created in a specifi c date span (condition), 359

creating pages properties, Contributor groups, 319

CSS (cascading style sheets), 68, 225-248. See also

CSS styles

color-coding options, 226-230

creating and attaching, 241-244

creating, modifying, and deleting styles, 235-239

CSS reports, 248

defi ning and storing styles, 227

history and basics, 227-228

identifying styles in, 230-234

inheritance, 228, 244-247

Style Application toolbar, 239-241

units of measurement, 352

CSS Properties task pane, 30

CSS Reports task pane, 31

CSS styles, 230-234

creating, modifying, and deleting, 235-239

defi ning and storing, 227

identifying in style sheets, 230-234

CssLink controls, 198

custom activities for workfl ows, 285

custom document properties (metadata), 9

Custom List, 105

custom list forms, 121

customized pages, 7. See also SharePoint sites

changing site’s default page, 69

client-side interactivity, adding, 65-67

creating, 47

CSS inheritance, 244-247

hyperlinks, adding, 56-58

images, adding, 62-65

master pages, 210-214, 221

resetting to un-customized pages, 20, 71-73, 221

ScreenTips, adding, 56-58

table layouts, 68

text, adding, 56-58

upgrading SharePoint Services and, 19

viewing, 48-55

Web components, adding, 59-61

customized sites

creating, 302-307

customizing one at a time, 44

customizing Common toolbar (exercise), 28

CustomValidator control, 191

D
Data Connection Library (DCL), 106

data controls, ASP.NET, 191-195

Data Form Web Parts (DFWPs), 5, 91, 122, 129

data source controls, ASP.NET, 189

Data Source Details task pane, 30

Data Source Library, 30, 158-164. See also data 

sources

exposing data on Web pages, 195-198

of other sites, connecting to, 160, 177-179

Data Source Properties dialog box, 168

data sources, 157-182. See also Data Source Library

connecting Web Parts, 180-182

displaying list contents of other sites, 160, 177-179

exposing in Data View controls, 195-198

linked sources, 160, 173-177

RSS Feed server-side scripts, 160, 168-170

RSS Feed XML fi les, 166

XML fi les as, 164-166

XML Web services, 171-172
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data validation, 189, 191-195

Data View controls, 195, 195-198

Data View Web Parts (DVWPs), 5, 91, 122, 129

converting List View Web Parts to, 151-153

creating, 130-133

customizing, 133-136

Data Views, 129-155

CAML, using, 149-151

conditional formatting, 137-142

connecting, 180-182

converting List View Web Parts to Data View 

Web Parts, 151-153

creating, 130-133

customizing, 133-136

exporting (deploying), 153-155

insertions, deletions, and updates, 146-148

XSLT, using, 143-146

database connections, 159

DCL (Data Connection Library), 106

Decision Meeting Workspace (site defi nition), 36

default master page, 203, 210. See also master 

pages

changing, 214-215

CSS fi le for (core.css), 230. See also inheritance in CSS

modifying, 220

validating styles with CSS Reports, 248

default page for SharePoint sites, 69

default.aspx page (home page), 49, 70, 71

defi nitions for SharePoint sites, 6, 7, 16, 36, 301, 308

changing for sites (disallowed), 41

creating site hierarchies, 35

creating, 309-310

CSS inheritance and, 244-247

differences between, 303

editing pages pointing to, 71. See also customized 

pages

Fabulous 40 site templates, 36, 309

list of, 35-36

for master pages, 205, 221-222

pages pointing to (un-customized pages), 7, 48-55

resetting customized pages to, 20, 71-73

reviewing site template contents, 311-312

testing solutions, 313-314

Delete Item action, 362

deleting

SharePoint sites, 43

Web pages, 100

Web Part connections, 182

dependency checking, 337

deploying Web Parts, 153-155

deploying workfl ows, 288-292

descriptions for sites, selecting, 42

Design permission, 318

Design view (of Web pages), 48, 49

detaching page layouts from pages, 271

DFWPs (Data Form Web Parts), 5, 91, 122, 129

dialog boxes

Accessibilities Properties, 63

Data Source Properties, 168

Find and Replace, 32

Microsoft Clip Organizer, 63

navigating, xii

Page Editor Options, 49-55, 229

Picture Properties, 64

Save Embedded Files, 64

dirty pages, 56

Discard Check Out Item action, 362

Discussion Board, 105

displaying contents in List View Web Parts, 160

Disposition Approval workfl ow, 277

DLLs (dynamic link libraries), 185, 186

Do Calculation action, 360

Document Center (site defi nition), 36

Document library, 104

document management

content approval process, 253

overview of, 251

Web Content Management, 251-273

document properties, custom, 9

document window (workspace)

overview of, 25

Web Site tab, 26

Document Workspace (site defi nition), 36

documents, copying between sites, 339-341

Don’t Attempt To Authentication option, 168

DVWPs (Data View Web Parts), 5, 91, 122, 129

converting List View Web Parts to, 151-153

creating, 130-133

customizing, 133-136

DWT (Dynamic Web Template), 3

dynamic content on Web pages, 47. See also

Web pages

dynamic Web Parts, 91

Dynamic Web Templates (DWTs), 3

E
e-mail messages, links in, 39

Edit With Microsoft Offi ce SharePoint Designer 

command, 13

editing properties, Contributor groups, 319

editing window, 48

editions of SharePoint Server 2007, 15

editors, confi guring, 25

elements style type (CSS), 228
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else-if condition branches in workfl ows, 296

em (unit of measurement), 352

EnableClientScript property, 191

Enterprise site defi nitions, 36

expiration of published content, 254

exploring Web pages, 48-55

exporting 

SharePoint sites, 332-336

Web Parts, 153-155

Expression Web, 3

F
Fabulous 40 site templates, 36, 309

Feature Stapling, 308

features (SharePoint Services), 37, 308

fi eld controls, 253

overview of, 258-259

modifying page layouts, 268-269

The fi le size in a specifi c range kilobytes 

(condition), 360

The fi le size is a specifi c type (condition), 360

fi le libraries, 9, 103. See also libraries, specifi c

copying between SharePoint sites, 336-339

as data source, 159

displaying contents in List View Web Parts, 

91, 111-115

exposing in Data View controls, 195-198

form pages, 121-127

permissions for, 81

view pages, 118-121

for Web Part pages (exercise), 83-85

fi le types, associating with editors, 25

fi les

custom document properties, 9

text, inserting into Web pages, 57

fi les reports, 325

Find 1 task pane, 31, 32

Find 2 task pane, 31

Find and Replace dialog box, 32

Find Data Source task pane, 30

Folder List task pane, 26, 29

folders properties, Contributor groups, 319

fonts for Web page text, 50

Form library, 104

form pages for lists, 121

formatting, conditional, 137-142

formatting properties, Contributor groups, 319

fpdatasources library, 162

frame style (Web Part zones), 87

FrontPage 2003, 3, 6

FTP for SharePoint site location, 40

Full Control permission, 318

.fwp fi les

copying lists and libraries, 336-339

overview of, 332-336

G
galleries, Web Parts, 90

general properties, Contributor groups, 319

GET method (HTTP), 168

ghosted (customized) pages, 7. See also SharePoint 

sites

changing site’s default page, 69

client-side interactivity, adding, 65-67

creating, 47

CSS inheritance, 244-247

hyperlinks, adding, 56-58

images, adding, 62-65

master pages, 210-214, 221

resetting to un-customized pages, 20, 71-73

ScreenTips, adding, 56-58

table layouts, 68

text, adding, 56-58

upgrading SharePoint Services and, 19

viewing, 48-55, 59-61

Web components, adding

global default master page, 206

global meeting workspace master page, 206

global navigation breadcrumbs, 8

Global site defi nition, 308

graphics

adding to pages, 59-61

alternate text for, 63

resizing, 64

Group Approval workfl ow, 277

GUIDs (globally unique identifi ers), 151

H
Header zone (Web Part pages), 83

help with SharePoint Designer, xxv

hierarchy of SharePoint sites

creating, 35-43

overview of, 8

History list, 279

home page (default.aspx)

overview of, 49, 71

renaming, 70

HTML controls, 186

HTTP GET and POST methods, 168

HTTP GET and POST methods  377
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hyperlinks

adding to Web pages, 56, 57

in e-mail, best practices for, 39

verifying, 328

Hyperlinks task pane, 31

I
icons for sites, selecting, 42

id attribute (controls), 187

ID style type (CSS), 228

image conversion tools, 62

images

adding to pages, 59-61

alternate text for, 63

resizing, 64

images properties, Contributor groups, 319

Import Spreadsheet list, 106

importing SharePoint sites, 332-336

infrastructure of SharePoint sites, 9

inheritance in CSS, 228, 244-247

inline style type (CSS), 228

input controls, validating data of, 189, 191-195

inserting text fi les into Web pages, 57

interactivity, client-side, 65-67

internal name (child sites), 37

Internet Options dialog box, 13

Issue Tracking list

creating (exercise), 108

overview of, 105

J
JavaScript fi les, linking to, 198

Join option (data sources), 173

K
KPI (key performance indicator) list, 106

L
Languages and Translators list, 106

Layers task pane, 30

layout, Web Parts, 88

Layout Tables task pane, 30

Left Web Part zone, 52

legal issues, 350

length of URLs, limits on, 38

LFWPs (List Form Web Parts), 121

libraries (for storing fi les), 9, 103. See also libraries, 

specifi c

copying between SharePoint sites, 336-339

as data source, 159

displaying contents in List View Web Parts, 91, 111

exposing in Data View controls, 195-198

form pages, 121-127

permissions for, 81

view pages, 118-121

for Web Part pages (exercise), 83-85

libraries, specifi c

Data Connection Library (DCL), 106

Data Source Library. See Data Source Library; 

data sources

Document library, 104

Form library, 104

fpdatasources library, 162

Pages document library, 258

pages library (meeting workspace), 78

Pages library (publishing sites), 78

Picture library, 104

Report library, 106

Shared Documents library, 70

Slide library, 106

Style Library, 230

Translation Management library, 106

Wiki Page library, 104, 108

licensing issues, 351

Limited Access permission, 318

linked data sources, 160, 173-177

links

adding to Web pages, 56, 57

in e-mail, best practices for, 39

verifying, 328

Links list, 105

List Form Web Parts (LFWPs), 121

list templates, 301

list view pages, 116, 118-121

List View Web Parts (LVWPs), 91

converting to Data View Web Parts, 151-153

creating, 111

customizing, 112-115

list view pages, creating, 118-121

list view pages, modifying, 116

list workfl ow actions, 285, 362

lists, 9, 103. See also lists, specifi c

built-in defi nitions for, 104, 106

copying between SharePoint sites, 336-339

creating new, 104-111

as data source, 159

displaying contents in List View Web Parts, 91. 

See also list view pages

displaying contents on other sites, 160, 177-179

exposing in Data View controls, 195-198

modifying in form pages, 121-127
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lists, specifi c

Announcements list, 9, 105, 111, 113

Contacts list, 105

Custom List, 105

Issue Tracking list, 105, 108

KPI (key performance indicator) list, 106

Languages and Translators list, 106

Links list, 105

Project Tasks list, 105

site type list, 40

Survey list, 105

Task list, 105, 279

Lists folder, 110

ListViewXml tag, 149

locations for SharePoint sites

naming URLs, 38

specifying (example), 40

Log to History List action, 361

login controls, ASP.NET, 189

look and feel. See cascading style sheets (CSS)

lookup columns, 196

LVWPs (List View Web Parts), 91

converting to Data View Web Parts, 151-153

creating, 111

customizing, 112-115

list view pages, creating, 118-121

list view pages, modifying, 116

M
major versions, content, 254

Manage Hierarchy permission, 318

Manage Styles task pane, 30, 34, 231

Marquee Web Component, 59-61

Master Page Gallery, 263, 269

master pages, 48, 71, 203-222

attaching to Web pages, 95

content placeholders and content regions, 216-221

creating, 220

creating content pages from, 98

customizing, 210-214

default, changing, 214-215

requests for publishing pages, 260

resetting to site defi nitions, 221-222

measurement units, CSS, 352

Meeting Workspace site defi nitions, 36, 78

menu bar (workspace), 25

Merge Cells option, 69

Merge option (data sources), 173

metadata (custom document properties), 9

Microsoft Clip Organizer dialog box, 63

Microsoft Expression Web, 3

Microsoft Offi ce programs and SharePoint 

technologies, 7

Microsoft Visual Studio 2005, 1, 3

accessing SharePoint sites with, 10

workfl ows, 283

Microsoft Windows SharePoint Designer,2-4

about,2-4

carrying out common tasks, 4

Expression Web vs., 3

interfaces for SharePoint sites, 10-14

viewing sites with, 10, 48

Microsoft Windows SharePoint Server 2007

editions of, 15

SharePoint Services and, 14

Microsoft Windows SharePoint Services, 6-10

SharePoint Server 2007 and, 14

upgrading, complications of, 19

minor versions, content, 254

Modifi ed by a specifi c person (condition), 359

Modifi ed in a specifi c date span (condition), 359

modulating customizations, 304

monthly summary report, 327

multi-step workfl ows, creating, 295-297

Multipage Meeting Workspace (site defi nition), 36

multiple-item forms, 146

My Site Host (site defi nition), 36

N
namespaces, 186

naming conventions

for components, 304

for Contributor groups, 318

for images, 64

for URLs, 38

naming home page, 70

navigation controls. ASP.NET, 189

Navigation task pane, 29

Navigation view, 26

nested master page, 204

.NET Framework 3.0, 276

Next Result button (Find 1 pane), 33

no-entry icon, 52

non-publishing pages, 49. See also customized 

pages

O
Offi ce programs and SharePoint technologies, 7

Offi ce SharePoint Server Publishing feature, 252

owners, site, 255

owners, site  379
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P
packaging solutions, 301-315

creating customized sites, 302-307

creating site templates, 309-310

reviewing site template contents, 311-312

testing solutions, 313-314

Page Editor Options dialog box, 49-55, 229

Page Fields, 195

Page Layout content type, 263

page layout designers, 255

page layouts, 252

built-in content types for, 263

creating, 263-267

detaching and reattaching, 271-272

fi eld controls, 253, 258-259, 268-269

modifying, 268-269

restoring from previous version, 269-271

Pages content type, 258

Pages document library, 258

pages library (meeting workspace), 78

Pages library (publishing sites), 78

parent master pages

CSS inheritance, 244-247

overview of, 204

Pause for Duration action, 361

Pause Until Date action, 361

permissions, 10

for customizing pages, 50

for data connection authentication, 161, 168

for libraries, 81

for SharePoint Designer, 318-321

Personal Web Packages (.fwp fi les)

copying lists and libraries, 336-339

overview of, 332-336

Personalization Site (site defi nition), 36

Picture library, 104

Picture Properties dialog box, 64

PlaceHolderLeftNavBar content region, 79

PlaceHolderMain control, 271

placeholders for content, 205

overview of, 216-221

permissions for, 319

PlaceHolderTitleInTitleArea content region, 79

POST method (HTTP), 168

practice fi les in this book, xi

Previous Result button (Find 1 pane), 33

privacy issues, 351

problem reports, 325

Project Tasks list, 105

projects, customized, 7. See also SharePoint sites

client-side interactivity, adding, 65-67

creating, 47

CSS inheritance, 244-247

default page, changing, 69

hyperlinks, adding, 56-58

images, adding, 62-65

master pages, 210-214, 221

resetting to un-customized pages, 20, 71-73

ScreenTips, adding, 56-58

table layouts, 68

text, adding, 56-58

upgrading SharePoint Services and, 19

viewing, 48-55

Web components, adding, 59-61

properties of controls, 187

prototyping, 5, 302

Proxy Settings option (Applications Options), 25

publishing pages, 49, 253, 260

Publishing Portal (site defi nition), 36

Publishing Site (site defi nition), 36, 252, 254

Publishing site defi nitions, 36, 37

Publishing Site with Workfl ow (site defi nition), 

36, 252, 254

Q
Quick Launch bar, 26

Quick Tag Selector, 53

R
RadEditor text editor, 345

RangeValidator control, 191

Read permission, 318

readability of URLs, 38

reattaching page layouts to pages, 271

Records Center (site defi nition), 36

Recycle Bin, 9, 100

Redirect Page content type, 263

region types, 319

RegularExpressionValidator control, 191

Remote Web Site command, 339-341

removing (deleting)

SharePoint sites, 43

Web pages, 100

Web Part connections, 182

renaming 

home page, 70

images, 64

Report Center (site defi nition), 36

Report library, 106

reports, CSS, 248

reports on SharePoint sites, 325-328, 355, 356

RequiredFieldValidator control, 191

Reset Workspace Layout option (Task Pane), 31
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resetting customized pages, 20, 71-73

resetting master page to site defi nition, 221-222

resizing images, 64

restoring

customized pages to original versions, 20

SharePoint sites from backup, 328-331

task panes, to default positions, 31

Restricted Read permission, 318

reusing customizations, 304

Right Column zone (Web Part pages), 83

Right Web Part zone, 52

RSS Feeds

exposing URL for aggregators, 199

server-side scripts, 160, 168-170

for XML fi les, 166

RSSLink controls, 199

S
Save Embedded Files dialog box, 64

Save This Username And Password option, 168

saved fi les, restoring from, 20 

saved library fi les, 9, 103. See also libraries, specifi c

copying between SharePoint sites, 336-339

as data source, 159

displaying contents in List View Web Parts, 91, 

111-115

exposing in Data View controls, 195-198

form pages, 121-127

permissions for, 81

view pages, 118-121

for Web Part pages (exercise), 83-85

saving un-customized pages as customized, 72

scheduling for publication, 254

ScreenTips, adding to Web pages, 56, 57

ScriptLink controls, 198

Search Center (site defi nition), 36

Search Center with Tabs (site defi nition), 36

security

data connection authentication, 161

privacy issues, 351

Send an Email action, 361

Server controls, 195, 198-200

server gallery (Web Parts), 90

server-side controls, 186, 191

server-side scripts, connecting to, 160, 168-170

Set as Home Page option, 70

Set Content Approval Status action, 361

Set Field in Current Item action, 361

Set Text Of Status Bar action, 65-67

Set Time Portion of Date/Time Field action, 361

Set Workfl ow Variable action, 361

shared content reports, 325

Shared Documents library, 70

SharePoint controls, 186

Data View controls, 195-198

in master pages, 205

Server controls, 198-200

SharePoint Designer

about, 2-4

carrying out common tasks, 4

Expression Web vs., 3

help, xxv

interfaces for SharePoint sites, 10-14

user permissions, 318-321

viewing sites with, 10, 48

SharePoint Designer workspace, 23-44

global meeting workspace master page, 206

overview of, 23-44

SharePoint properties, Contributor groups, 319

SharePoint Server 2007

editions of, 15

SharePoint Services and, 14

SharePoint Services, 6-10

SharePoint Server 2007 and, 14

upgrading, complications of, 19

SharePoint site templates, 6, 7, 16, 36, 301, 308

built-in, list of, 35-36

changing for sites (disallowed), 41

creating site hierarchies, 35

creating, 309-310

CSS inheritance and, 244-247

differences between, 303

editing pages pointing to, 71. See also customized 

pages

Fabulous 40 site templates, 36, 309

list of, 35-36

for master pages, 205, 221-222

pages pointing to (un-customized pages), 7, 48-55

resetting customized pages to, 20, 71-73

reviewing site template contents, 311-312

testing solutions, 313-314

SharePoint sites, 3, 317-341. See also Web pages

accessibility reports, 356

accessibility standards, 350-355

backing up and restoring, 328-331

color schemas, 347-350

copying documents between, 339-341

copying lists and libraries between, 336-339

customizing, 302-307

customizing individually, 44

default page for, changing, 69

deleting, 43

exporting and importing, 332-336

hierarchy of, 8, 35-43
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SharePoint sites (continued)

 home page (default.aspx), 49

infrastructure of, 9

interfaces for, 10-14

organizing, 4

reports on, 325-328, 356

resetting to site defi nitions, 20, 71-73

templates for. See site defi nitions and site 

templates

usability issues, 344-347

user permissions (Contributor Settings), 317-341

viewing Web pages, 48-55

Simple Object Access Protocol (SOAP), 171

single-item forms, 146

site collection level, 107

Site Collection Template Gallery, 310

site collections

creating, 35-43

overview of, 8

site columns, 107

site defi nitions and site templates, 6, 7, 16, 36, 301, 

308

built-in, list of, 35-36

changing for sites (disallowed), 41

creating site hierarchies, 35

creating, 309-310

CSS inheritance and, 244-247

differences between, 303

editing pages pointing to, 71. See also customized 

pages

Fabulous 40 site templates, 36, 309

list of, 35-36

for master pages, 205, 221-222

pages pointing to (un-customized pages), 7, 48-55

resetting customized pages to, 20, 71-73

reviewing site template contents, 311-312

testing solutions, 313-314

site defi nitions, specifi c

Basic Meeting Workspace (site defi nition), 

36, 78-81

Blank Meeting Workspace, 36

Blank site, 36

Blog, 36

Collaboration Portal, 36, 254

Decision Meeting Workspace, 36

Document Center, 36

Document Workspace, 36

Multipage Meeting Workspace, 36

My Site Host, 36

Personalization Site, 36

Publishing Portal, 36

Publishing Site, 36, 252, 254

Publishing Site with Workfl ow, 36, 252, 254

Records Center, 36

Report Center, 36

Search Center, 36

Search Center with Tabs, 36

Site Directory, 36

Social Meeting Workspace, 36

Team site, 36

Wiki site, 36

Site Directory (site defi nition), 36

site-level content types, 107

Site Manager Contributor group, 318

site master page, 214

site owners, 255

site reports, 325-328, 355, 356

Site Settings page, 42

site template galleries, 310

site templates, 6, 7, 16, 36, 301, 308

built-in, list of, 35-36

changing for sites (disallowed), 41

creating site hierarchies, 35

creating, 309-310

CSS inheritance and, 244-247

differences between, 303

editing pages pointing to, 71. See also customized 

pages

Fabulous 40 site templates, 36, 309

list of, 35-36

for master pages, 205, 221-222

pages pointing to (un-customized pages), 7, 48-55

resetting customized pages to, 20, 71-73

reviewing site template contents, 311-312

testing solutions, 313-314

site type list, 40

sizing images, 64

Slide library, 106

SOAP (Simple Object Access Protocol), 171

Social Meeting Workspace (site defi nition), 36

solution fi les, 308

solutions, building, 301-315

creating customized sites, 302-307

creating site templates, 309-310

reviewing site template contents, 311-312

testing solutions, 313-314

<span> tags, 65

SPCalendarNavigation controls, 199

SPDataSource control, 146

specifi city, CSS, 228

Splendid 7 templates, 310

Split view (of Web pages), 48, 55

SPWebPartManager control, 205

standard controls, ASP.NET, 189-191

stapling features to site confi gurations, 308

Start menu, xii
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starting SharePoint Designer, 25, 27

starting workfl ows, 278

Startup options, 27

static content on Web pages, 47. See also

Web pages

static Web Parts, 92

status bar, Web page, 65-67

status bar, workspace, 25

Stop Workfl ow action, 361

storing fi les in libraries, 9, 103. See also libraries, 

specifi c

copying between SharePoint sites, 336-339

as data source, 159

displaying contents in List View Web Parts, 91, 111, 

112-115

exposing in Data View controls, 195-198

form pages, 121-127

permissions for, 81

view pages, 118-121

for Web Part pages (exercise), 83-85

.stp fi les, 309, 311-312

Style Application toolbar, 239-241

style in use (CSS), 228

Style Library, 230

style sheets, 68, 225-248

color-coding options, 226-230

creating and attaching, 241-244

creating, modifying, and deleting styles, 235-239

CSS reports, 248

defi ning and storing styles, 227

history and basics, 227-228

identifying styles in, 230-234

inheritance, 228, 244-247

Style Application toolbar, 239-241

units of measurement, 352

styles, CSS, 230-234

creating, modifying, and deleting, 235-239

defi ning and storing, 227

identifying in style sheets, 230-234

subsets of sites, copying, 336-339

subsites (child sites), 8

child master pages, 204

creating site hierarchies, 35-43

CSS inheritance, 244-247

site collections, 8, 35-43

summary reports, 325

Survey list, 105

system master page, 214

T
table backgrounds, 69

Table button (Common toolbar), 68

table layouts for Web pages, 68

Table Properties dialog box, 69

Tag Properties task pane, 29, 186

Task list, 105, 279

task panes (workspace), 25, 29-35

task panes, specifi c

Accessibility task pane, 31

Apply Styles task pane, 30

Behaviors task pane, 30, 65

Clip Art task pane, 31, 34, 62

Clipboard task pane, 31, 33, 34

Compatibility task pane, 31

Conditional Formatting task pane, 30

Contributor task pane, 31, 34

CSS Properties task pane, 30

CSS Reports task pane, 31

Data Source Details task pane, 30

Find 1 task pane, 31, 32

Find 2 task pane, 31

Find Data Source task pane, 30

Folder List task pane, 26, 29

Hyperlinks task pane, 31

Layers task pane, 30

Layout Tables task pane, 30

Manage Styles task pane, 30, 34, 231

Navigation task pane, 29

Tag Properties task pane, 29, 186

Toolbox task pane, 30, 186, 187

task workfl ow actions, 285, 363

team site properties, 71

Team site (site defi nition), 36

TEMPLATE folder, 6, 71

templates for SharePoint sites, 6, 7, 16, 36, 301, 308

built-in, list of, 35-36

changing for sites (disallowed), 41

creating site hierarchies, 35

creating, 309-310

CSS inheritance and, 244-247

differences between, 303

editing pages pointing to, 71. See also customized 

pages

Fabulous 40 site templates, 36, 309

list of, 35-36

for master pages, 205, 221-222

pages pointing to (un-customized pages), 7, 48-55

resetting customized pages to, 20, 71-73

reviewing site template contents, 311-312

testing solutions, 313-314

templates for Web Part pages, 82

templates for workfl ows, 277, 282

testing workfl ows, 288-292

text

adding to Web pages, 56

appearing in status bar, 65-67

attributes of, 49-55

in place of graphics, 63
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text editors, 345

Theme controls, 198

Three-state workfl ow, 277

thumbnails, generating automatically, 62

title (Web Part zones), 87

title bar (SharePoint Designer workspace), 51

title bar (Web Part zone), 84

title bar (workspace), 25

Title, Description, And Icon page, 42

Title fi eld contains keywords (condition), 359

titles for sites, selecting, 42

toolbars (workspace), 28

Toolbox task pane, 30, 186, 187

top-level sites, 8. See also un-customized pages

creating site hierarchies, 35-43

deleting, 44

Translation Management library, 106

Translation Management workfl ow, 277

triggering workfl ows, 278

U
un-customized pages, 7

CSS inheritance and, 244-247

editing, 71. See also customized pages

resetting customized pages to, 20, 71-73

resetting master page to, 221-222

viewing, 48-55

un-ghosted pages. See un-customized pages

units of measurement, CSS, 352

unsaved pages, 56

Updated List Item action, 362

upgrading SharePoint Services, 19

URLs, naming, 38

usability issues, 344-347

accessibility reports, 355

accessibility standards, 350-355

AKS (Accessibility Kit for SharePoint), 353

color schemas, 347-350

usage reports, 325

Use Windows Authentication option, 168

V
validating hyperlinks, 328

validation controls, ASP.NET, 189, 191-195

ValidationSummary control, 191

verifying 

hyperlinks, 328

workfl ows, 288-292

view controls, ASP.NET, 189

View Only permission, 318

view pages for lists, creating, 118-121

ViewFields element (CAML), 149

viewing pages, 48-55

vision issues (accessibility)

AKS (Accessibility Kit for SharePoint), 353

color schemas, 348

reports on, 355

standards for, 350-355

visitors (to Web pages), 255

visual aids, 52

Visual Studio 2005, 1, 3

accessing SharePoint sites with, 10

workfl ows, 283

W
Wait For Field Change in Current Item action, 361

WCAG (Web Content Accessibility Guidelines), 350, 

353

Web browsers

to create Web Part pages, 82-85

settings for Web Parts, 88

to view SharePoint sites, 10

Web components, adding to pages, 59-61

Web Content Accessibility Guidelines (WCAG), 350, 

353

Web Content Management, 251-273

creating page layout, 263-267

detaching/reattaching page layout, 271-272

enhancements in SharePoint Server 2007, 253-258

modifying page layout, 268-269

page model, 258-262

restoring page layout, 269-271

Web Designer Contributor group, 318

Web master bottleneck, 4

Web page controls, 185-200

ASP.NET standard controls, 189-191

ASP.NET validation controls, 189, 191-195

calendar, 199

Data View controls, 195-198

inserting and modifying, 186-188

Server controls, 198-200

Web page customization, 7. See also SharePoint 

sites

adding client-side interactivity, 65-67

adding images, 62-65

adding text, ScreenTips, and hyperlinks, 56-58

adding Web components, 59-61

changing site’s default page, 69

creating, 47

CSS inheritance, 244-247
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master pages, 210-214

resetting to un-customized pages, 20, 71-73, 221

table layouts, 68

upgrading SharePoint Services and, 19

viewing, 48-55

Web pages, 77-101, 160. See also SharePoint sites

adding client-side interactivity, 65-67

adding images, 62-65

adding text, ScreenTips, and hyperlinks, 56-58

adding Web components, 59-61

ASP.NET pages, creating, 85

attaching CSS fi les to, 241-244

content pages, creating from master page, 98

default for Web site, changing, 69

deleting, 100

detaching/reattaching page layouts, 271

exploring, 48-55

master page, attaching, 95

text attributes, 49-55

viewing, 48-55

Web Part pages, creating, 82-85

Web Part zones, inserting, 87

Web Parts, adding or modifying, 90-95

Web pages, un-customized, 7

CSS inheritance and, 244-247

editing, 71. See also customized pages

resetting customized pages to, 20, 71-73

resetting master page to, 221-222

viewing, 48-55

Web Part galleries, 90

Web Part pages

creating, 82-85

list form pages, 121

list view pages, 118-121

Web Part zones, 52, 261

inserting in Web pages, 87

modifying page layouts, 268

Web Parts, 5, 9, 71

connecting, 180-182

deploying (exporting), 153-155

dynamic and static, 92

list view and built-in, 91

modifying page layouts, 268

task pane for, 30

in Web pages, adding and modifying, 90-95

Web Parts, Data Form (DFWPs), 5, 91, 122, 129

Web Parts, Data View (DVWPs), 5, 91, 122, 129

converting List View Web Parts to, 151-153

creating, 130-133

customizing, 133-136

Web Parts, List Form (LFWPs), 121

Web Parts, List View (LVWPs), 91

converting to Data View Web Parts, 151-153

creating, 111

customizing, 112-115

list view pages, creating, 118-121

list view pages, modifying, 116

Web-safe color palette, 348

Web services, 171-172

Web Site tab (document window), 26

Web sites, 3, 317-341. See also Web pages

accessibility reports, 356

accessibility standards, 350-355

backing up and restoring, 328-331

color schemas, 347-350

copying documents between, 339-341

copying lists and libraries between, 336-339

customizing, 44, 302-307

default page for, changing, 69

deleting, 43

exporting and importing, 332-336

hierarchy of, 8, 35-43

home page (default.aspx), 49

infrastructure of, 9

organizing, 4

reports on, 325-328, 356

resetting to site defi nitions, 20, 71-73

templates for. See site defi nitions and site 

templates

usability issues, 344-347

user permissions (Contributor Settings), 317-341

viewing Web pages, 48-55

webbots, 59-61

WebParts controls, ASP.NET, 189

WebUIValidation.js fi le, 191

Welcome Page content type, 263

Welcome.aspx page, requests for, 260

WF (Workfl ow Foundation), 276

Wiki Page library, 104, 108

Wiki site (site defi nition), 36

Windows Explorer, to view SharePoint sites, 10

Windows Server 2003, 15

Windows SharePoint Designer, about, 2-4

carrying out common tasks, 4

Expression Web vs., 3

interfaces for SharePoint sites, 10-14

viewing sites with, 10, 48

Windows SharePoint Server 2007

editions of, 15

SharePoint Services and, 14

Windows SharePoint Services, 6-10

SharePoint Server 2007 and, 14

upgrading, complications of, 19

Windows Workfl ow Foundation, 276

Windows XP, book exercises and, xi

workfl ow activities, 285

Workfl ow Designer, 5
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workfl ow rules, 285

workfl ow steps, 285

workfl ows, 5, 275-298

conditions and actions, 285-288, 359-363

creating, 282-284

deleting, 297-298

how to use, 276-281

modifying, 292-295

multi-step, creating, 295-297

SharePoint Designer vs. Visual Studio 2005, 283

verifying and deploying, 288-292

workfl ows, specifi c

Approval workfl ow, 277

Collect Feedback workfl ow, 277

Collect Signatures workfl ow, 277

Disposition Approval workfl ow, 277

Group Approval workfl ow, 277

Publishing Site with Workfl ow (site defi nition), 

36, 252, 254

Stop Workfl ow action, 361

Three-state workfl ow, 277

Translation Management workfl ow, 277

Workfl ows folder, 289

workspace for SharePoint Designer

global meeting workspace master page, 206

overview of, 23-44

World Usability Day (WUD) Community, 344

WSDL (Web Service Description Language), 171

.wsp fi les, 308

X
XML fi les, as data source, 159, 164-166

XML language, about, 134

XML Web services, 160, 171-172

.xoml fi les, 289

.xoml.rules fi les, 289

.xoml.wfconfi g.xml fi les, 289

XPath language, 143

xsl<<COLON>>template element, 143

XSLT language, 129, 143-146

Z
zone title (Web Part zones), 87
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